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THE ENERGY CONSERVATORY, INC.  SOFTWARE PRODUCT LICENSE AGREEMENT
(appears during software installation)

This legal document is an agreement between the end user (hereinafter “Licensee”) and The Energy Conservatory, Inc.
(hereinafter "TEC").  This agreement constitutes the complete agreement between the licensee and TEC for this software
program, which includes computer software and may include associated media, printed materials and electronic
documentation (hereinafter “Software Product”) .

BY SELECTING THE YES BUTTON BELOW, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT,
YOU UNDERSTAND IT AND YOU AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS, WHICH INCLUDE
THE SOFTWARE PRODUCT LICENSE, THE EXPRESS LIMITED WARRANTY AND THE LIMITATION OF
WARRANTY AND LIABILITY (Collectively the "Agreement").  THIS AGREEMENT APPLIES TO YOU AND ANY
SUBSEQUENT LICENSEE OF THIS SOFTWARE PRODUCT.

IF YOU DO NOT ACCEPT OR AGREE TO THE TERMS OF THIS AGREEMENT, PRESS THE NO BUTTON BELOW.

1.  THE ENERGY CONSERVATORY, INC. SOFTWARE PRODUCT LICENSE

A.  GRANT OF LICENSE.  TEC grants to licensee a non-exclusive right to use this copy of the Software Product on a single
computer at a single location.  This Software Product is licensed, not sold, to you by TEC and may be used, in object code
form only and only in conjunction with testing hardware and software programs authorized by TEC. You agree not to
translate, reverse engineer, reverse compile, disassemble or make derivative works from this Software Product.  You may
neither sublicense the Software Product, nor sublicense or assign the license granted under this agreement, without prior
written authorization from TEC.  TEC reserves all rights not expressly granted to licensee.

B.  OWNERSHIP OF SOFTWARE.   TEC retains title and ownership of the Software Product.  This license is not a sale of
the original Software Product or any copy thereof.

C.  COPY RESTRICTIONS.   The Software Product and any accompanying documentation are copyrighted.  Unauthorized
copying of the Software Product, including software that has been modified, merged, or included with other software, or of
any accompanying documentation is expressly forbidden.

2.   EXPRESS LIMITED WARRANTY

TEC warrants that the Software Product will perform substantially in accordance with the accompanying written materials for
a period of 90 days from the date of receipt by the licensee.

3. LIMITATION OF WARRANTY AND LIABILITY

The foregoing warranty is in lieu of all other warranties and is subject to the conditions and limitations stated herein.  TEC
MAKES NO WARRANTY OR REPRESENTATION, EITHER EXPRESSED OR IMPLIED, WITH RESPECT TO THIS
SOFTWARE PRODUCT, INCLUDING ITS QUALITY, RESULTS OBTAINED, PERFORMANCE,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

THE EXCLUSIVE REMEDY OF THE PURCHASER FOR ANY BREACH OF WARRANTY shall be the return of the
Software Product to TEC for replacement, or, at the option of TEC, refund of the purchase price.

IN NO EVENT WILL TEC OR ITS DISTRIBUTORS OR AGENTS BE LIABLE FOR INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR THE INABILITY TO USE THE
SOFTWARE PRODUCT, even if advised of the possibility of such damages.  In particular, TEC is not responsible for any
costs including, but not limited to, those incurred as a result of lost profits or revenue, loss of the use of the software, loss of
data, the cost of recovering such software or data, the cost of substitute software, or the claims of third parties.  In any case,
TEC’s maximum liability for any and all losses, injuries or damages (regardless of whether such claims are based on contract,
negligence, strict liability or other tort) shall be the purchase price paid for the Software Product.

This limitation of Warranty and Liability may not be amended or modified, nor may any of its terms be waived except by a
writing signed by an authorized representative of TEC.
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Chapter 1     Introduction to TECTITE

TECTITE (Ver. 3.2) is a building airtightness test analysis program for Windows computers.  The
TECTITE program can be used with the Model 3 or Model 4 Minneapolis Blower DoorÔ  or the Series A
and B Duct BlasterÒ fans to conduct fully automated Blower Door airtightness tests.  During an automated
Blower Door test, the program controls the speed of the Blower Door fan, prompts for installation or
removal of flow rings, records both building pressure and fan airflow, and calculates and stores test results.
TECTITE can also be used to analyze and display manually collected Blower Door test data.

1.1  TECTITE Features

·  Computerized control of Minneapolis Blower Door fans using either a DG-700 Digital Pressure Gauge
or an APT system.

·  Choice of pre-set test protocol (CGSB 149.10-M86) or custom test options.
·  Calculation and display of airtightness test results.
·  Measurement and display of multiple building zone pressures during the Blower Door test (requires

APT system with 3 or more pressure channels).
·  Automated operation and on-screen instructions reduce operator error, eliminates time spent zeroing

gauges and adjusting fan speed, and ensures that tests are conducted the same way every time.
·  Multiple simultaneous pressure measurements of building pressure and fan airflow reduce the

variability of test results from wind.
·  Cruise control for maintaining a constant building pressure during diagnostic tests or airsealing

activities.
·  Built-in report generator and file storage features.
·  Compare feature generates test result comparison for any 2 previously saved building test files.
·  On-line HELP screens.
·  Manual mode for analyzing and displaying manually collected test data.

During automated testing, TECTITE adjusts the speed of the Blower Door fan while simultaneously
monitoring the building pressure and fan airflow using 2 differential pressure channels built into either the
DG-700 gauge or the APT’s Data Acquisition Box (DAB).  One pressure channel is used to measure
building pressure while the other pressure channel is used to measure Blower Door fan airflow.
Communications between the DG-700 or DAB and your computer is provided through an RS-232 serial
communication link.

1.2  Auto Versus Manual Operation

The TECTITE program can be run using two different operating methods:

·  The program can be used to fully automate a Blower Door airtightness test using the DG-700 gauge or
an APT DAB (Auto Method).

·  The program can be used to enter and analyze manually collected Blower Door test data (Manual
Method).

 
The two different operating methods are selected from the Test Settings Screen (using the Method field).
The Test Settings Screen is discussed in more detail later in Chapter 6.  Much of the operation of the
TECTITE program is the same for both Auto and Manual Methods.
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1.3  Help Buttons

Each screen in the TECTITE program contains a Help button to provide you with detailed information for
that screen.  Wherever you see the Help button, clicking on it will open a text window.  We recommend that
you use all the Help buttons the first time you run the program.

1.4  Installing TECTITE for Windows

Before starting the install process, make sure you have at least 8 MB of hard drive space available. Place
the TECTITE diskette or CD in the appropriate drive on your computer. From the Start button, open the
Control Panel.

From the Control Panel window, click on Add/Remove Programs and then click on Install .

The computer will locate the TECTITE installation program on the floppy disk or CD and guide you
through the remainder of the installation process.



Chapter 2    Setting Up the Hardware for Automated Testing

TECTITE
Version 3.2

3

Chapter 2     Setting Up the Hardware for Automated Testing

Note:  If you will not be conducting automated Blower Door tests, skip to Chapter 3.

2.1  Hardware Set Up Using a DG-700

1. Install the Blower Door system as described in the Blower Door operation manual.

2. Connect the DG-700 to your computer using a 9-pin serial cable.  The male end of the cable should be
plugged into the serial communication port on the top of the gauge, and the female end of the cable
should be plugged into an open serial communication port on your computer.

Note:  If your computer does not have a serial port, but does have a USB port, you will need to
purchase an after-market USB to Serial Port adapter (contact TEC for adapter recommendations).

3. Connect the DG-700 to the Blower Door fan speed controller using the fan control cable. Plug one end
cable into the 3.5 mm fan control output on the top of the DG-700, and plug the other end of the cable
into the communication jack on the side of the fan speed controller box.  Note:  If your Blower Door
speed controller does not have a communication  jack on the side of the controller box, you will need to
either purchase a new speed controller, or have a communication jack installed on your existing
controller. Contact The Energy Conservatory (www.energyconservatory.com) to determine if your
existing controller can be modified, or if you will need to purchase a new controller.

4. Connect tubing between the DG-700 and the Blower Door system (tubing connections are detailed in
the Blower Door operation manual).

Serial  Communication Port Fan Control
Output Jack

To inside of building
(leave open if gauge is
in the building)

To outside (green
tubing)

To space upstream of fan inlet.
(If fan inlet and gauge are in the
same space, leave open)

To  BD fan
(red tubing)

A B
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5. Turn on the DG-700.  Now turn on the Blower Door fan speed controller in the “just on” position (the
fan should not be turning in this position).

Hardware Set Up with DG-700

2.2  Hardware Set Up Using an APT System

1. Install the Blower Door system as described in the Blower Door operation manual.

2. Connect the APT Data Acquisition Box (DAB) to your computer using a 9 pin serial cable.  The male
end of the cable should be plugged into the COM port on the end of the DAB, and the female end
should be plugged into an open serial communication port on your computer.

Communications Ports/Switches on the DAB

Note:  If your computer does not have a serial port, but does have a USB port, you will need to
purchase an after-market USB to Serial Port adapter (contact TEC for adapter recommendations).

DC
12V

OFF

ON FAN
COM

Fan Control
Cable

To Power Source

Serial Cable
To Computer

Building Pressure
Green Hose
(A Reference)

Fan Pressure
Red Hose
(B Input)

Fan Power
Cord
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3. Connect the Blower Door fan speed controller to the DAB using the fan control cable provided. The
phone plug end of the cable is plugged into the Fan Control Output Jack on the end of the DAB while
the other end of the cable is plugged into the communication jack on the side of the speed controller.
Note: If you have purchased a new Blower Door with your APT system, the system includes a  speed
controller with a built-in communication jack. If your older Blower Door speed controller does not
have a communication jack, you will need to purchase a new speed controller.

4. Connect tubing between the DAB and the Blower Door system (tubing connections are detailed in the
Blower Door operation manual).  Note: If you will be measuring building zone pressures during the
airtightness test using Channels P3 – P8, refer to Chapter 10 for more information on installing tubing
from the DAB to the zones to be tested.

5. Turn on the DAB (plug in the DAB’s power supply if necessary).  If the DAB’s internal NiCad battery
is fully charged, it should supply power for approximately 6 hours of continuous operation.  Now turn
on the Blower Door fan speed controller in the “just on” position (the fan should not be turning in this
position).

Hardware Set Up with APT System

To outside
(green tubing)

To inside of building
(leave open if DAB is
in the building)

To  BD fan
(red tubing)

To space upstream of fan inlet.
(If fan inlet and DAB are in the
same space, leave open)

INPUT

REF

P1 P2

Serial Cable
To ComputerBuilding Pressure

Green Hose
(P1 Reference)

Fan Pressure
Red Hose
(P2 Input)

To Power SourceFan Power
Cord

Phone Cord
To Controller

Extra Outlet for
DAB 12V Power
Supply or for
Computer
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DAB Mounting Board:

If you purchased the APT and Blower Door system together, the Data Acquisition Box (DAB) comes
fastened to a black ABS plastic mounting board.  The mounting board also contains two electrical outlets
and the Blower Door fan speed controller.  Attach the mounting board to a door, table or horizontal surface
using the C-clamp on the back of the board (the C-clamp can be rotated for horizontal surfaces).

DAB Mounting Board for APT Systems

The speed controller is connected to the fan by plugging one end of the fan extension cord into the Blower
Door fan electrical box, and connecting the other end to the pig tail plug coming out the bottom side of the
speed controller.  The upper pig tail plug coming out of the controller should be plugged into one of the two
electrical outlets located above the controller on the mounting board (see diagram above).  The extra
electrical outlet on the mounting board can be used for the DAB 12V power supply, or to power your laptop
computer.

2.3  Optional Computer Stand:

The Energy Conservatory sells an optional
laptop computer stand for conducting
automated Blower Door tests. To use the
computer stand, first open the stand tripod to
the desired height and attach the flat tray.
Now gently clamp the digital gauge board or
DAB mounting board to the aluminum
tripod pole using the adjustable C-clamp on
the back of the board.  Place your computer
on the tray and you are now ready to make
the connections between the computer, the
DG-700/DAB and the speed controller.
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Chapter 3      Setting Up the Building for Testing

After installing the Blower Door system, you will need to set up the building in its normal heating or
cooling mode.  This typically includes closing adjustable openings and preparing combustion appliances.
Refer to your Blower Door manual for more specific instructions (or refer to set-up guidelines
provided to you from other sources).

3.1  Adjustable Openings

·  Close all storm and prime windows.
·  Close all exterior doors and attic or crawlspace hatches connected to conditioned spaces.
·  Open all interior doors to rooms that are heated or cooled.  The object here is to treat the entire

building as one connected space.  Because few basements can be completely sealed from the building
and usually some conditioning of basement air is desirable, they are typically included as conditioned
space.

·  Tape plastic over window air conditioners if they appear to be a source of air leakage into the building
and they are removed during the heating season.

3.2  Combustion Appliances/Exhaust Devices

·  Adjust all combustion appliances so they do not turn on during the test.  This is commonly done by
temporarily turning off power to the appliance, or setting the appliance to the “pilot” position.  Note:  If
vented combustion appliances turn on during a depressurization test, it is possible for flames to be
sucked out of the combustion air inlet (flame rollout).  This is a fire hazard and can possibly result in
high CO levels.

·  Be sure that fires in fireplaces and woodstoves are completely out.  Take precautions to prevent ashes
from being blown into the building during the test.  In most cases closing dampers and doors is
sufficient, but when they are leaky or absent, it will be necessary to tape fireplace doors shut, clean out
the ashes, or cover the ashes with newspaper.

·  Turn off all exhaust fans, vented dryers, air conditioners and air handler fans.
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Chapter 4     Starting the TECTITE Program

4.1  Starting TECTITE 3.2

To start TECTITE, click on  Start...Programs...Energy Conservatory...TECTITE 3.2.

The main TECTITE screen will now appear, with the Main Menu containing File, Options, Goto and Help
located in the upper left hand corner.

Main TECTITE Screen

3.2
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Chapter 5    Overview of TECTITE (Auto and Manual Methods )

5.1  Starting a New Test

To start using the TECTITE program, open the File Menu by clicking on File in the Main Menu.  The top
of the File Menu contains four starting options:

�  New Test   is selected to begin a new building airtightness test using the factory default
program settings.  Selecting this option automatically loads all factory default settings and
takes you to the Customer Info Screen.

�  New Test with Custom Configuration   is selected to begin a new building airtightness test
using custom configuration files which you have previously created and saved.  Using
configuration files is the most efficient way to run TECTITE.  Creating and saving
configuration files is discussed in Chapter 14.  After selecting a configuration file to load,  the
Customer Info Screen will appear.

�  Retrieve Existing Test  lets you recall a previously saved building test file.  After selecting the
building test file to retrieve, the values from the retrieved file are loaded into the program, and
the Customer Info Screen appears.  Once a file is recalled, it may be viewed, edited and re-
saved (with the same or a different file name).  Refer to Chapter11 for more information on
retrieving and saving files.

�  Compare Tests   lets you recall two previously saved building test files and compare the saved
test results.  After selecting the two test files to compare, a compare test results screen
appears.  Refer to Chapter 18 for more information on using the Compare Tests feature.

Menu choices are selected by clicking on the desired option.  We recommend that first time users begin by
selecting New Test.  The other starting options should be explored after familiarizing yourself with the
TECTITE program.

5.2  Input Screens

The first 4 pages of TECTITE are input screens where you will enter information about the customer, the
building being tested, local climatic conditions and any relevant comments that you would like to save
along with the test file.  An overview of the 4 screens are shown on the next page.  You can click on
individual fields to enter information, or use the Tab key to quickly move between fields.  To clear a
screen, click on the Clear button at the bottom of each page.  When you are finished with a screen, click on
the Next button to proceed.  At any time, you can step back to earlier screens by using the Previous button.
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Customer, Building, Climate and Comment Screens

Customer Information Screen:
   The Customer Information Screen is used to
   input the name, address and phone number
   of the customer for whom the airtightness
   test is being performed.

Building Information Screen:
   The Building Information Screen is used to
   input the address and physical infomation
   for the building being tested.

Climate Information Screen:
   The Climate Information Screen is used to
   enter weather information needed to
   calculate weather-dependent test results
   (e.g. design infiltration rates).  Indoor and
   outdoor temperature are also entered from
   this screen.

Comments Screen:
   The Comments Screen is used to enter an
   unlimited number of lines of comments on
   the building being tested.  Comments are
   stored with the test file and are printed out
   along with the Detailed Report.
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5.3  Auto Test Method

After completing the Comments Screen, click on Next to move to the Test Settings Screen.  (Note:  If you
want to operate in Manual Mode, refer to the Manual Test Method section below.)

5.4  Manual Test Method

After completing the Comment Screen, click on Next to move to the Test Settings Screen:

Test Settings Screen:
   The Test Settings Screen is used to input
   settings that will be used during the
   airtightness test.  When using TECTITE to
   conduct automated tests, be sure the Method
   button is set to Auto.  Click on Next to move
   to the Test Graph Screen.

Test Graph (Auto Method):
   The automated airtightness test and cruise
   control features are controlled from this
   screen.  During an automated test, Blower
   Door test data are collected by TECTITE
   at a series of target building pressures, which
   are designated by the vertical blue lines on
   the graph.  To begin a test, click on the Start
   Test button.

Test Settings Screen:
   To set the program for manual entry of
   Blower Door test data (i.e. building and
   fan pressure readings), be sure the Method
   button is set to Manual.  Click on Next to
   move to the Test Graph Screen.

  Ring  A
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5.5  Test Results (Auto and Manual Methods)

Test Graph (Manual Method):
   When using Manual Method, manually
   entered test data are displayed on this screen.
   To begin entering data, click on the Data
   Table button.

Data Table:
   The data table is used to input Blower Door
   test data that were collected manually, rather
   than collected automatically by TECTITE.
   The data table will allow entry of up to 10
   sets of Blower Door test readings, plus one pre-
   test and one post-test baseline building
   pressure reading.  The inclusion of baseline
   readings in the table allows for quick
   adjustments to entered test readings for
   baseline stack and wind effects.  After you
   have entered all data into the table, click on
   OK to return to the Test Graph.

Test Results:
  To look at the calculated test results, click on
  Next from the Test Graph Screen.  Test results
  are automatically calculated using all data points
  displayed on the graph, and values input into
  the building, climate and test settings screens.

  Note:  If you are conducting an automated test,
  and were measuring zone pressures during the
  Blower Door test, a Next button will appear at
  the bottom of the Test Results Screen.  Clicking
  on the Next button will take you to the Zone
  Data Screen.
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5.6  Zone Data (Auto Method Only)

5.7  Using the Goto Menu

The Goto item in the Main Menu allows you to quickly move to any active screen within the TECTITE
program.  Clicking on Goto will bring up the following dialog box.

Simply click on one of the active choices to immediately move to that screen.  If no test data have been
taken, the Test Results and Zone Data Screens will not be available.

Zone Data:
  To look at the measured zone data, click on
  Next from the Test Results Screen.  Zone data is
  only available if you are using an APT DAB with
  3 or more pressure channels and have activated
  the Zonal Pressures feature from the Test Setting
  Screen.
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Chapter 6    Editing the Input and Test Settings Screens

6.1  Customer Information Screen

The Customer Information Screen is used to input the name, address and phone number of the customer for
whom the airtightness test is being conducted.  You may also input the name of the technician performing
the test.  The customer’s name and address are included in both the Customer and Detailed Reports.  All
information entered on this screen is stored as part of the test file.

You can click on individual fields to enter information, or use the Tab key to quickly move between fields.
To clear the Customer Information Screen, click on the Clear button.  When you are finished entering the
customer information, click on Next to move to the Building  Information Screen.

Customer Information Screen

6.2  Building Information Screen

The Building Information Screen is used to input the address and physical information for the building
being tested.  If any of the fields on this screen are left blank, the test can still be completed, however test
results requiring those inputs will not be calculated or displayed on the Test Results Screen.  All
information entered on this screen is stored as part of the test file.

You can click on individual fields to enter information, or use the Tab key to quickly move between fields.
To clear the Building Information Screen, click on the Clear button.  When you are finished entering
building information, click on Next to move to the Climate Information Screen, or Previous  to move back
to the Customer Information Screen.
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Building Information Screen

Building Address, City, State, Zip:   Fill out these fields if the address for the building being tested is
different from the address on the Customer Screen.

Volume:   Enter the building volume in cubic feet.  If you are testing a building, we recommend that you
include the basement if it is to be kept closer to inside temperature than outside temperature.  (If you
include the basement in the volume, perform the Blower Door test with the door between the basement and
the building kept open.)  If you enter a value of 0 (or leave the field blank), all test results requiring the
volume will not be calculated or printed (e.g. Air Changes per Hour at 50 Pascals).

Surface Area:   Enter the above grade surface area of the exterior envelope of the building, in square feet.
Include all surfaces separating the conditioned space of the building from unconditioned  spaces (e.g.
exterior walls, floors over unheated and vented crawlspaces, surfaces separating the building and the attic).
This variable is used to calculate the Minneapolis Leakage Ratio (discussed in the results section).  If you
enter a value of  0 (or leave the field blank), the Minneapolis Leakage Ratio will not be calculated.

# of Bedrooms:   Enter the number of bedrooms for the building being tested. This number is used to
determine ventilation requirements. The occupancy of the building is assumed to be the number of
bedrooms plus one or the number of occupants (see below), whichever is larger.

Floor Area:   Enter the floor area of the building in square feet.  Include all floors in intentionally heated
spaces.  If you have included the basement in your volume calculation, also include the basement in the
floor area calculation.  If you enter a value of  0 (or leave the field blank), CFM50/square foot of floor area,
the estimated natural infiltration rate and the mechanical ventilation guideline will not be calculated.

# Stories:   Enter the number of stories, which are above grade, for the building being tested.  The
numberof stories is used in the infiltration models which estimate annual average and design
infiltrationrates.  Because the infiltration models assume an average floor height of 8 feet, calculate the
number of stories by taking the average above grade height of the building (in feet), and dividing by 8.  For
unheated crawl spaces, do not include the above grade crawl space in the building height.
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# of Occupants:    Enter the number of occupants that are living in the building.  When determining the
occupancy of a building, the program uses either the # of occupants, or the # of bedrooms plus one,
whichever is greater.

Heating Fuel Type:   Click on the fuel type used for heating..

Heating Fuel Cost:   Enter the fuel cost for the selected heating fuel type.  For example, for natural gas
(Gas), enter the cost in $ per CCF.

Heating Efficiency:    Enter the annual efficiency (i.e. AFUE) for the heating system.  For example, for a
gas furnace with an 82.5% AFUE, enter 82.5.

Electric Cost for Cooling:   Enter the cost per KWH for the cooling system.  For example, enter 0.08 if
your electrical rate is 8 cents per KWH.

SEER Rating of Cooling System:   Enter the SEER rating for the cooling system.

Wind Shield Factor:   Click on the appropriate building wind shielding class.  The wind shield factor is
used in the infiltration model which estimates natural infiltration rates.

Shielding Class Description:

Heavy: Very heavy shielding; large obstructions surrounding the perimeter
within two building heights; typical downtown shielding.

Shielded: Obstructions around most of the perimeter, building or trees within 30
feet in most directions; typical suburban shielding.

Moderate: Some obstructions within two building heights, thick hedge, solid 
fence or one neighboring building.

Light: Few obstructions, a few trees or a small shed.
Exposed: No obstructions.

6.3  Climate Information Screen

The Climate Information Screen is used to enter weather information needed to calculate certain air
leakage test results such as the estimated annual and design infiltration rates, the annual cost of air   leakage,
and the ventilation guideline.  Indoor and Outdoor Temperature inputs are required to complete a building
airtightness test and must always be entered prior to beginning a test.  If any of the other fields on this
screen are left blank, the test can be completed.  However, test results requiring those inputs will not be
calculated or displayed on the Test Results Screen.  All information entered on this screen is stored as part
of the test file

To enter climate information, you can use the Select Climate Location button (see below), or you can click
or Tab through the individual fields to enter the information manually.  To clear the Climate Information
Screen, click on the Clear button.  When you are finished entering climate data, click on Next to move to
the Comment Screen, or Previous to move back to the Building Information Screen.

Note:  The Indoor and Outdoor Temperature fields must be entered manually.
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Climate Information Screen

Using the Select Climate Location button:

TECTITE contains a listing of climate data from selected cities in the United States and Canada.  You can
automatically load this information into the Climate Information Screen by clicking on the Select Climate
Location button, and then selecting the city closest to your test site using the Location field which appears
in the screen.  To use the Location field, first click on the selection arrow to bring up the list of cities.  Now
browse through the list using the up and down arrows and then click on the city closest to your test site.
The climate data for the selected city will appear in the right hand column of the location window.  To
automatically load this information into the Climate Information Screen, click on OK.

Selecting Climate Location
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Indoor Temperature:   Enter the indoor temperature (in degrees F) at the beginning of the test.  This is a
required field that must be entered manually.

Outdoor Temperature:   Enter the outdoor temperature (in degrees F) at the beginning of the test.  This is
a required field that must be entered manually.

Heating Degree Days:   Enter the number of base 65 degree F heating degree days for the location closest
to the building being tested.   This field is used in the estimation of annual air leakage costs.

Cooling Degree Days:   Enter the number of base 70 degree F cooling degree days for the location closest
to the building being tested.   This field is used in the estimation of annual air leakage costs.

Energy Climate Factor:   Enter the energy climate adjustment factor for the location closest to the building
being tested.  The energy climate factor is used to estimate the average annual natural infiltration rates for
purposes of estimating the annual cost of air leakage.  The energy climate factor is part of a simplified
version of the LBL infiltration model developed by Max Sherman, and is discussed in more detail in
Appendix E of the Operation Manual for the Model 3 Minneapolis Blower Door.  The calculation
procedure for estimating the annual cost of air leakage can be found in the Model 3 Operation Manual.

Ventilation Weather Factor:   Enter the ventilation weather factor for the location closest to the building
being tested.  The ventilation weather factor is used to estimate the average annual natural infiltration rate
for purposes of estimating ventilation rates due to infiltration.  The calculation procedure used to estimate
average annual ventilation rates is based on ASHRAE Standard 136-1993. Ventilation weather factors can
be found in Standard 136-1993.

Design Winter Temperature Difference and Wind Speed:    Enter the design winter temperature
difference and wind speed for the location closest to the building being tested.  The design winter
temperature difference and wind speed are used to calculate the infiltration rate under design winter
conditions.  The estimated design infiltration rate can be used in ACCA Manual J load calculations in lieu
of Manual J’s infiltration estimation procedure.  The calculation procedure used to estimate design
infiltration rates is based on the LBL infiltration model and is discussed in more detail in the ASHRAE
Fundamentals Handbook, Chapter on Infiltration and Ventilation.

Design Summer Temperature Difference and Wind Speed:   Enter the design summer temperature
difference for the location closest to the building being tested.  Enter your best estimate of design summer
wind speed (data source not available, 7 MPH appears to be commonly used in the HVAC industry).   The
design summer temperature difference and wind speed are used to calculate the infiltration rate under design
summer conditions.  The estimated design infiltration rate can be used in ACCA Manual J load calculations
in lieu of Manual J’s infiltration estimation procedure.  The calculation procedure used to estimate design
infiltration rates is based on the LBL infiltration model and is discussed in more detail in the ASHRAE
Fundamentals Handbook, Chapter on Infiltration and Ventilation.

6.4  Comments Screen

The Comments Screen can be used to enter an unlimited number of lines of comments on the building
being tested.  Comments are saved along with the building test file and can be printed out as part of the
detailed test report.  Typical comments entered on this screen include client interview  information, building
and weather conditions during the test, the location of major air leakage sites  etc.  To clear the Comments
Screen, click on the Clear button.  When you are finished entering comments, click on Next to move to the
Test Settings Screen, or Previous to move back to the Climate Information Screen.
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Note:  You can access standard Windows copy and paste commands within the Comments Screen by
clicking on the right mouse button.  This allows you to easily move text between TECTITE and other
Windows programs such as Microsoft Word.

6.5  Test Settings Screen

The Test Settings Screen is used to set up the airtightness test procedures to be used by the TECTITE
program. You can click on individual fields to enter information, or use the Tab key to quickly move
between fields.  When you are finished selecting test settings, click on Next to move to the Test Graph
Screen(s), or Previous  to move back to the Comments Screen.  Note:  When using the Manual Method for
data entry, only Test Mode and Method are active.

Test Settings Screen

Test Mode:

Select Pressurize if the Blower Door will be blowing air into the building (i.e. the building will be at a
higher pressure than outside), or select Depressurize if the Blower Door will be blowing air out of the
building (i.e. the building will be at a lower pressure than outside).  The factory default setting is
Depressurize.

Method:

Click on Manual if you will be manually entering the Blower Door airtightness test readings (i.e. house and
fan pressure readings), or select Auto if TECTITE will be used to perform an automated test.
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Test Pressures (only available when Auto Method is chosen):

Select the target building pressures at which Blower Door data will be collected by clicking on the
appropriate button.

�  CGSB standard (149.10-M86):    consists of an 8 point Blower Door test conducted at
building target pressures varying from 50 to 15 Pascals.  For most users, this is the preferred
test method.

�  Custom:     allows the user to create a custom list of up to 10 target building target pressures
at which Blower Door data will be collected.  Once Custom has been selected, click on the
Edit Custom Pressures button to open the list of custom target building pressures.  Click on
the Help button on the custom pressure list window for more information.

Zonal Pressures (only available when Auto Method is chosen):

If you are using an APT DAB with 3 or more pressure channels, you can activate the Zonal Pressures
feature (by clicking on the Active button) to allow the measurement of building zone pressures using
installed pressure channels P3 – P8 during the normal airtightness test sequence.  Once activated, the
Settings button can be used to access the Zonal Pressures Set-Up Screen. Click on the Help button in the
Zonal Pressures Set-Up Screen, or refer to Chapter 10  for more information on using this feature.

Auto Test Parameters (only available when Auto Method is chosen):

�  Samples Per Station:   The Samples Per Station field is the number of readings (or samples)
of building pressure and fan flow that are taken at each pressure station (i.e. target building
pressure) during an automated test.  Each reading or sample is displayed on the graph as a
small dot as it is collected.  The default number of samples is 100, and should work fine for
most test applications (you may vary this number from 1 to 1000).  In most cases, larger
numbers of samples will lead to higher correlation coefficients.  If the Zonal Pressures
feature is active, the Samples Per Station also determines the number of zone pressure
measurements taken for each active zone pressure channel.

If the CGSB test standard is selected, the number of samples per station is also used to
determine the number of pre and post test baseline building pressure readings that are taken
during an automated test sequence.

�  Fan Adjust Rate:   During either an automated airtightness test or a cruise procedure, the
computer is in charge of adjusting the fan speed to reach the desired (or target) building
pressures.  The Fan Adjust Rate determines how quickly the fan speed changes as the
computer tries to achieve the target building pressure.  For most cases, the factory default Fan
Adjust Rate of 0.5 will work fine. In some cases, such as windy weather, it may be necessary
to reduce the fan adjust rate to prevent the fan from responding too quickly to pressure
changes caused by the wind.  In such cases, try a lower setting (e.g. 0.2 or 0.1) so that  the fan
adjusts slowly enough to successfully complete the test.  If you would like to speed up fan
response, try a higher setting (e.g. 1.0 or 2.0).

Note:  When changing the Fan adjust rate, do not enter values greater than 5 or less than 0.1.
In addition, the fan speed can be manually adjusted by dragging the manual fan speed
adjustment slider on the Test Graph, or by pressing down on the Up and Down arrow keys
(the arrow keys are only active when the manual adjustment slider is highlighted).



Chapter 6    Editing the Input & Test Settings Screens

TECTITE
Version 3.2

21

�  Target Tolerance:   The Target Tolerance is used by TECTITE to determine whether the
measured building pressure is close enough to the target building pressure so that data
collection may begin.  The Target Tolerance is a number (in Pascals) stating how close the
actual building pressure needs to be to the target pressure before a reading will be taken.  In
most cases the factory default setting of 2 (Pa) works fine. In windy weather you may need to
increase the target tolerance (e.g. 3 or 4) to account for the fluctuations in building pressure
caused by the wind.  The target tolerance used has little impact on the final test results, but
your particular test standard (e.g. CGSB) may require you to get very close to your target
pressures.

Note:  If during an automated test you would like to manually instruct the computer to go
ahead and take data, click on the SAMPLE button.  At this point the computer will proceed
with data collection just as if it had decided that the target tolerance had been met.

�  Building High Pressure Limit:    If TECTITE detects a building pressure higher than the set
Building High Pressure Limit, the fan will shut off immediately and you will be informed
that the maximum allowable building pressure was exceeded.  The purpose of the Building
High Pressure Limit is to prevent damage to the building from excessive test pressures.  The
default setting is 90 Pa.  Note: The Blower Door fan calibration parameters are not accurate
above test pressures of 80 Pascals.

�  Fan Start %:    Enter a number, typically in the range 1% to 25%.  At the beginning of an
automated test or cruise procedure, the fan output signal from the DG-700/DAB will
immediately be set to this value to reduce the delay associated with fan startup.  A good value
for this parameter can be determined by manually moving the fan control slider and estimating
at which point the fan begins to turn.  This allows you to customize the computer control to
the particular combination of fan motor and controller being used.  This value is stored in the
building test files (.bld) and configuration files (.cfa).  The default value is 0.

The Fan Start % setting will not affect the minimum fan output which may occur during
cruising or automated testing.  The computer will still be allowed to reduce the fan output
below the Fan Start % value if needed to achieve low target pressures.

Note:  If you input an inappropriately high Fan Start  % setting, the fan will begin operation
at a high speed and may trigger the warning message (Exceeded Maximum Building
Pressure).  Reduce the Fan Start % setting if this occurs.

�  Restore Factory Settings:   The Restore Factory Settings button will restore the factory
default settings for all five Auto Test Parameter fields.
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Chapter 7    Conducting an Automated Airtightness Test

7.1  Overview of Test Graph Screen (Auto Method)

The automated airtightness test is conducted from the Test Graph Screen.  The main feature of the Test
Graph Screen is a plot of Blower Door fan flow (or building leakage) on the vertical axis versus building
pressure on the horizontal axis.  During a Blower Door test, data are automatically collected at a series of
pre-set target building pressures, which are designated by the vertical (blue) lines on the graph.  If you have
selected the CGSB Test Pressures (from the Test Settings Screen), there will be 8 target pressure lines at
50, 45, 40, 35, 30, 25, 20 and 15 Pascals of building pressure.  If you selected Custom Test Pressures
(from the Test Settings Screen), a blue target pressure line will appear for each value that you input into the
Custom Target Pressure List.

Test Graph Screen (Auto Method)

*   Building pressure values shown on the graph and in the Bldg Pressure status window are adjusted for the
     measured baseline pressure (displayed in the Bldg Baseline status window).
** Zonal pressure values shown in the Zone Pressure status windows are adjusted for measured zonal
     baseline pressure.

During the automated test sequence, the Blower Door fan will turn on and increase speed until the building
pressure reaches the highest target pressure line shown on the graph (e.g. 50 Pa for a CGSB test).  Once the
appropriate building pressure is achieved, TECTITE takes a number of simultaneous measurements of
building pressure and fan flow (the default number of samples is 100).  Each sample is displayed on the
graph as a small dot as it is collected.  When the system is finished collecting samples for the first target
pressure, the average value of all samples for that target pressure is displayed as a red circle.  The fan speed
is then reduced until the building pressure reaches the next target pressure line and the data collection
process is repeated.
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If the Zonal Pressures feature has been activated from the Test Settings Screen, the Zone Pressure status
window will display the current measured zone pressures during the course of the automated test.  While
TECTITE is collecting data for the building airtightness test (from Channels P1 and P2), it will also collect
data from each active zone pressure channel (P3 – P8).  The number of data samples taken for each active
zone pressure channel is determined by the Samples per Station field in the Test Settings Screen.

In addition to the graphical display, TECTITE will provide a series of messages or prompts on the Test
Graph Screen to ensure that proper testing procedures are followed.  The DAB Status Box directly below
the Graph will also provide information on the current operating status of the DG-700 or APT DAB.  The
system also detects common testing or equipment problems (e.g.  tubing connected to the wrong  pressure
tap) and provides a warning message to the operator.

7.2  Selecting the Fan Model

Before beginning a test, be sure that the selected fan model displayed at the top of the Test Graph Screen
matches the Blower Door fan being used.  To change the selected fan model, click on Options located in
the Main TECTITE Menu.  From the Options Menu, select Fan Info.

Fan Information Window

In the Fan Information window, select the appropriate fan model (or type), and then click on OK.  You may
also input a fan serial number which will be stored along with the building test file, and is printed out on the
detailed test report.  Importantly, if you change the selected fan model while test data are displayed on the
graph, the test data will be automatically cleared.

Note:  The selected flow ring may be changed directly on the Test Graph Screen by clicking on the
selection arrow to the right of the indicated ring.  However, in most cases you will not need to change the
selected ring from this screen, because TECTITE will prompt you for flow ring selection during the
automated test sequence.
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7.3  Starting an Automated Test

Whenever you are in the Test Graph (Auto Method) Screen, TECTITE checks to be sure that your
computer and DG-700 or APT DAB are communicating properly. Automated testing cannot begin until a
communication link has been established.

If a communication link has not been established, the Start and Cruise buttons are grayed out and the
message DATA BOX NOT CONNECTED  appears in the DAB Status Window.  To establish
communication, first check to be sure that the serial cable between the computer and the DG-700/DAB has
been properly installed.  Also check that the DG-700/DAB has been turned ON and has power (plug in the
power supply to the DAB if you are unsure if its internal batteries are charged).  Once a communication link
has been established, the message Idle -  Monitoring  appears in the DAB Status Window and the Start and
Cruise buttons are activated.

For more information on establishing communication between the your computer and the DG-700/DAB, see
Chapter 15.

Start Test Button:

Clicking on the Start Test button will begin an automated airtightness test sequence.  TECTITE will guide
you through the test sequence using a series of operator messages.

An automated test sequence includes the following steps:

1. The operator is prompted to cover the fan inlet so that TECTITE can measure the baseline building
pressure (due to wind and stack effects) prior to the test.  If you are using a Model 3 or 4 Blower Door
fan install the no-flow plate; if you are using a Duct Blaster fan install the nylon fan cap,  then click on
OK.

2. TECTITE will automatically make a number of pre-test baseline pressure measurements (the default
number of readings is 100 ) and then display the average value of these readings in the Bldg Baseline
(Pa)  status window on the right side of the screen.  All subsequent building pressure measurements
shown on the graph and in the Building Pressure status window will be adjusted by this measured
baseline pressure.  Note:  TECTITE will also measure the baseline pressure for any active zone
pressure channel at the same time.

3. The operator is prompted to remove the fan inlet cover and install the appropriate flow ring on the fan
for the beginning of the test.  Use your best judgment and install the flow ring that you think will
provide the correct air flow for the highest target pressure.  Don’t worry if you guess wrong, the
program will instruct you to install a different ring later on if you start with the wrong one.  Click on
OK after you’ve removed the inlet cover and installed the chosen flow ring.

4. The operator is now prompted to indicate which flow ring was installed on the fan.  Select the
appropriate ring and click on Proceed with Test.

5. The fan will automatically turn on and increase speed until the building pressure reaches the highest
target pressure line shown on the graph (50 Pa for a CGSB test).1   The current fan flow and building
pressure is shown on the graph by the moving Fan Flow and Building Pressure Cursor.  Once the
appropriate target building pressure is achieved, TECTITE takes a number of simultaneous readings of
building pressure and fan flow (the default number of readings is 100).  Each reading is displayed on
the graph as a small dot as it is collected.  Once the program is finished collecting readings for the first
target pressure line, the average value of all readings for that target pressure is displayed as a red circle.
The fan speed is then reduced until the building pressure reaches the next lowest target pressure line

                                                
1   If the program is unable to reach the highest target pressure line with the fan running full speed, the operator will be
prompted to change to the next larger flow ring.  If the fan is in open configuration and still not able to reach the
highest target pressure line, the program will display the message “Can’t Reach Target Pressure...Collecting Data at
Highest Building Pressure” (see Section below  - Operator Messages During the Automated Airtightness Test).
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and the data collection process is repeated.  Note:  If the Zonal Pressures feature has been activated
from the Test Settings Screen, the Zone Pressure status window will display the current measured zone
pressure during the course of the automated test.  While TECTITE is collecting data for the building
airtightness test (from Channels P1 and P2), it will also collect and store data from each active zone
pressure channel (P3 – P8).

6. After data have been collected for the last target pressure line, the fan turns off and the operator is
again prompted to cover the fan inlet for another set of baseline building and zone pressure readings.
After taking the post-test baseline readings, the “Bldg. Baseline (Pa)” field is updated with the average
value for both pre and post test building baseline readings.

7. All airtightness test data shown on the graph are now automatically adjusted for the average of the two
building baseline readings, and the test is completed.  A “best fit” line is then drawn through the data.

8. Calculated building airtightness test results can be seen on the Test Results Screen by clicking on Next.
The measured zone pressure data are available from the Zone Data Screen (click Next from the Test
Results Screen, or use the Goto Menu Item).

Using the Sample Button (manually activating data collection):

The Sample button is used to manually activate data collection for a target building pressure line during an
automated test sequence, rather than waiting for TECTITE to automatically activate data collection.  This
button is particularly useful if it is windy and the building pressures are fluctuating.

Using the Clear Button (Clearing Data From the Graph):

The Clear button is used to clear all Blower Door data from the graph.  This will not affect the information
that you have entered into the test input screens, or any results that you have previously saved.

Conducting and Displaying Multiple Tests on the Same Graph:

Data from more than 1 automated test can be displayed on the Test Graph at one time.  This occurs when
conducting a second airtightness test (using Start Test) and not clearing data before beginning the next test.
If data from multiple tests are displayed on the graph, test results are calculated using all displayed data.
Combining multiple tests can increase the repeatability of test results, which is particularly useful in windy
weather.  The # of tests displayed on the Graph is shown by the Completed Test indicator.

Using the Pause Button:

Once an automated test has been initiated, the Pause button can be used to temporarily pause the test
sequence.  After clicking on Pause, the fan will turn off and the message  The Test Is Paused  appears on
screen.  From this message box, the user has 3 options:

�  Clicking on Adjust Auto Test Settings allows you to change the Fan Adjust Rate, the Target
Tolerance, the Building High Pressure Limit and the Fan Start % fields during the middle of
a test.

�  Clicking on Proceed With Test will restart the test sequence from where the Pause button
was activated.

�  Clicking on Stop Test allows you to end the current test sequence.

7.4  Stopping an Automated Test

In addition to using the Pause button, the fan can be quickly turned off during a test by pressing the Esc
key, or by clicking on the Stop Test button.  After the fan has been turned off, the user can choose to end
the current test sequence, or can restart the test.  If data from more than one test are being displayed on the
graph, stopping a test will not clear data from previously completed tests.  In addition, stopping a test will
not affect information that you have typed into the test input screens or have previously saved.
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7.5  Adjusting the Auto Test Parameters

The Test Settings Screen contains a number of  Auto Test Parameter fields which are used to adjust data
collection and fan control variables during the automated test sequence.  Refer to Chapter 6 for a detailed
description of each of the Auto Test Parameter fields.

7.6  Operator Messages During the Automated Test

During the airtightness test, the TECTITE program provides a series of on-screen messages or prompts to
the operator to ensure that proper testing procedures are followed.  In addition, the program detects
common testing or equipment problems (e.g.  hoses connected to the wrong pressure tap) and provides a
warning message to the operator.  Below is a listing of on-screen test procedure and operator warning
messages provided by the TECTITE program:
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On- Screen Test Procedure Messages    Operator Action Required
Cover fan inlet to measure starting building
pressure baseline.  Press OK when ready.
                              or
Cover fan inlet to measure ending building
pressure baseline.  Press OK when ready.

Cover the fan inlet so that TECTITE can measure the baseline
building pressure (due to wind and stack effects) prior to, or
following completion of the test.  If you are using a Model 3 Blower
Door install the no-flow plate; if you are using a Duct Blaster install
the nylon fan cap.

Remove fan inlet cover and install appropriate
flow ring.  Press OK when ready.

Remove the no-flow plate or nylon fan cap from the fan inlet so that
the fan can be turned on.  Install the flow ring that you think will
provide the appropriate air flow for the beginning of the test.

Which flow ring is installed? Select the flow ring that is currently installed on the fan, and then
click on Proceed with Test.

Install Ring _  and press here to continue test,
OR   Press here to end test at previous test
pressure.

TECTITE has determined that a different flow ring should be
installed on the fan.  Install the ring listed in the message.  If the
listed ring is not available, or you wish to end the test at this point,
click on the end test message.2

Remove all rings and press here to continue
test,  OR   Press here to end test at previous test
pressure.

TECTITE has determined that all low flow rings should be removed
from the fan.  Remove all rings from the inlet of the fan.  You may
also select to end the test at this point.

This will end testing.  Do you wish to end it?
or

This will end cruising.  Do you wish to end it?

This message appears when you have pressed Esc or clicked on Stop
Test during a test, or while the cruise control feature is active.  To
end the test or turn off cruise control, click on Yes.

On-Screen Warning Messages   Operator Action Required
Can not reach target pressure and have open
fan.  Collecting data at highest building
pressure.

No action required.  If the fan is in open configuration (i.e. no flow
plates installed), running at full speed, and not able to reach the
target pressure line, TECTITE will automatically collect data for
that target pressure at the highest achievable building pressure.

Warning:  Wrong sign (+/-) on building
pressure.  Check A/P1.  Press OK to terminate
test.

The measured building pressure on Channel A/P1 is changing in the
wrong direction from the indicated Test Mode.  Check to be sure
the A/P1 Reference tap is connected to the outside, the A/P1 Input
tap is measuring the pressure inside of the building, and that the
direction of the Blower Door fan flow is consistent with the
indicated Test Mode (i.e. depressurization vs. pressurization). Click
on OK to end test.

Warning:  Wrong sign (+/-) on fan pressure.
Check B/P2.  Press OK to terminate test.

The measured fan pressure on Channel B/P2 is changing in the
wrong direction.  Check to be sure the B/P2 Input tap is connected
to the Blower Door fan, and the B/P2 Reference is measuring the
pressure in the space upstream of the fan inlet.  Click on OK to end
test.

Warning:  Not detecting fan pressure.  Check
B/P2.  Press OK to terminate test.

The measured fan pressure on Channel B/P2 is less than 1 Pa, but
the building pressure is changing.  Possible fan pressure tubing
disconnect.  Check to be sure the B/P2 Input tap is connected to the
Blower Door fan, and the B/P2 Reference is measuring the pressure
in the space upstream of the fan inlet. Click on OK to end test.

Warning:  Not detecting fan or building
pressure.  Check system.  Press OK to terminate
test.

TECTITE is not detecting a fan or building pressure reading, even
though the program is calling for full fan speed.  Check building
and fan pressure tubing connections to the DG-700/DAB.  If the fan
was not running, check the fan speed controller to make sure:
- It is properly connected to the fan and plugged into power.
- The speed control knob is turned on.
- The speed controller is properly connected to the DG-700/DAB.
Click on OK to end test.

                                                
2  If you end the test and data has been collected for at least one previous target pressure line, test results will be
calculated using all data collected prior to ending.
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On Screen Warning Messages Operator Action Required
Warning:  At full fan speed but <2 Pa building
pressure.  Check system.  Press OK to terminate
test.

The measured building pressure on Channel A/P1 is less than 2 Pa
when the fan is at full speed.  First check to be sure the A/P1
Reference tap is connected to the outside, and the A/P1 Input is
measuring the pressure inside of the building.  Second, check that
outside windows and doors in the building are closed and that there
are no other large openings to the outside preventing the building
pressure from changing. Click on OK to end test.

Warning:  Not detecting building pressure on
A/P1.

TECTITE is not detecting a change in building pressure, even
though the fan pressure is at least 50 Pa.  Check to be sure that  one
end of the (green) building reference tubing is connected to the
A/P1 Reference tap, and that the other end is placed outside of the
building and away from the Blower Door fan flow.  Click on End
Test to terminate test.

Advanced Users:  If you are conducting an advanced diagnostic
procedure where you are trying to maintain or measure very small
(or zero) building pressures (e.g. “cruising zero”), you can
temporarily turn off this message by checking the Turn off this
warning box.

Warning:  Excessive building pressure
fluctuation.  Check A/P1 tubing/increase Target
Tolerance.

While attempting to reach a target pressure line, the measured
building pressure has been fluctuating beyond the Target Tolerance
for more than 90 seconds. To determine the cause of the fluctuating
building pressure problem, and the appropriate operator action,  see
Chapter 15.  To proceed with the test, click on Proceed with Test,
or choose Cancel Test to end the current test sequence.

Warning   Maximum allowable building
pressure exceeded. Do you wish to terminate
test?

The default maximum allowable measured building pressure is 90
Pascals.  This maximum pressure is designed to prevent accidental
damage to the building being tested.  In addition, calibration
formulas for the Blower Door fans may not be accurate at back
pressures greater than 90 Pascals, depending on the flow ring
installed and the fan pressure. Click on Yes to end test.

Note:  If you input an inappropriately high Fan Start % (on the
Test Settings Screen), the fan will begin operation at a high speed
and may trigger the maximum pressure warning.  Reduce the Fan
Start % setting if this occurs.  In addition, lowering the Fan
Adjust Rate (also on the Test Settings Screen) may also help to
prevent this message inadvertently being triggered at the start of test
procedure.

No test pressures available. If the Test Pressure field has been set to Custom, and you have not
entered any building pressure values into the custom pressure list
(see test Setting Screen), this message appears.  Enter building
pressure values into the custom pressure list, or change the Test
Pressure field to CGSB.

Data for more than one test will be combined
on the graph.

Data for more than one test can be combined and displayed on the
Test Graph at one time.  This occurs when conducting a second
airtightness test (by pressing the Start Test button) without clearing
previously collected data from the graph.  Once multiple test data
are combined, test results are calculated using all values from each
target pressure line.   The primary reason to combine data from
multiple tests is to increase the repeatability of test results in windy
weather.

If you would like to save the current test data before adding
additional data points, select Cancel Test and then save the data
using the File menu.  Select Proceed with Test to combine data
from multiple tests on the graph.
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On Screen Warning Messages             Operator Action Required
Communication lost.  Testing ended.
                             or
Communication lost.  Cruising ended.

Communication between the DG-700/DAB and your computer have
been disrupted, and the current test or cruise procedure has been
ended.  If you were conducting an airtightness test when
communication was lost, the test sequence is ended and all data
from the current test are cleared from the graph.

Note:  If the fan is still running, it can be stopped by completely
turning off the knob on the fan speed controller.

Lost communication can be caused by a poor connection between
the DG-700/DAB and your computer, or by a loss of power to the
DG-700/DAB.  Check the serial cable between the computer and
the DG-700/DAB, and check to be sure the DG-700/DAB is turned
on.  If you are unsure if the DAB’s internal battery is charged, plug
in the power supply to the DAB.  Click on OK to return to the Test
Graph Screen.  See Chapter 15 for more information on lost
communications.

Warning:  Flow too small to measure.  Press
OK to terminate test.

You are trying to measure a fan flow below the acceptable operating
range of the equipment.  Click on OK to end the test.

Cannot start the test because there are not
enough pressure channels for the existing test
data.  Do you wish to clear the data and
proceed with the test?

You are trying to combine data for more than 1 test, and the current
APT DAB being used has fewer pressure channels than were used
during the first test.  For example, this message would appear if a 5
pressure channel DAB was used to record 3 zone pressures during
the first test, and you are now using a 4 pressure channel DAB to
combine data with the first test.  Click on Yes to clear all existing
test data and proceed with a new test, or click on No to end the
current test sequence.

Warning: Data box due for re-calibration. The DG-700/DAB should be re-calibrated once per year.  If it has
been more than 1 year since the last calibration (based on your
computer’s internal clock), this message will appear.   The
calibration date for your DG-700/DAB can be found on the
calibration sticker located on the bottom of the unit, or click on
Data Box Info from the Test Graph (Auto Method) Screen.

Low Battery Warning.  Press OK to end
procedure.

The program has detected that the DG700/DAB battery is low.
Automated testing and cruise procedures can not begin.  If the low
battery warning appears during the middle of an automated test, the
current test sequence will be ended and all data from the current test
will be cleared.

The DAB is powered by an internal re-chargeable NiCad battery.
Plug in the 12V power supply supplied with the APT system to
charge the NiCad battery.  The fully charged NiCad battery will
power the DAB for approximately 6 - 12 hours of testing.  The
DAB can be also be operated with the power supply plugged in.

The DG-700 is powered by 6 AA batteries located in the back
battery compartment.  The battery voltage can be viewed by
clicking on the DATA BOX INFO button. If the battery voltage
drops below 6.1 Volts then TECTITE produces a Low Battery
warning and the LCD screen shows a flashing BAT indicator.  As
long as the voltage is above 5.5 Volts, the gauge will still make
accurate readings.  Once the voltage drops below 5.5 volts, the LCD
will show LO BAT and any active TECTITE test or cruise
procedure will be terminated and the data discarded.  Therefore it is
advisable to replace the batteries the first time the low battery
warning is displayed and before the voltage drops to the 5.5 Volt
level.
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7.7  Manually Adjusting the Fan Speed

The fan speed can be manually adjusted by dragging the Manual Fan Speed adjustment slider on the Test
Graph Screen, or by pressing down on the Up and Down arrow keys.  In order for manual fan speed
adjustment to work, a communication link between the computer and DG-700/DAB must have been
established, and the message Idle - Monitoring  should appear in the DAB Status Window.  If the message
DATA  BOX NOT CONNECTED appears in the DAB Status Window, you will need to establish a
communication link.  See Chapter 15, Problem 1 for more information on establishing a communication
link.

7.8  Real-Time ACH50 Estimator

During Idle - Monitoring  (or when the Cruise Control feature is active), TECTITE can display a real-time
estimate of Air Changes per Hour at 50 Pascals of building pressure in the ACH50 Status Window.  To
estimate ACH50, TECTITE uses the current measured fan flow, the volume estimate input into the Building
Information Screen, and an assumed Building Leakage Curve exponent (n value) of 0.65.  The ACH50
Status Window is only active when the current building pressure is between 40 and 60 Pascals, and a valid
fan flow measurement is being made. The Real-Time ACH50 display is useful for quickly estimating
building leakage rates before conducting a full airtightness test.

Note:  The Real-Time ACH50 estimator is not active during an automated test sequence.

Real-Time ACH50 Estimator

  Ring  A

ACH50 Estimator Window
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7.9  Using the Display Large Meters Feature

The Display Large Meters feature replaces the graph on the Test Graph (Auto Method) Screen with 3 large
status windows showing Real-Time ACH50, Current Fan Flow, and Current Building Pressure.  The feature
can be toggled on and off by clicking on Display Large Meters from the Options Menu.

The Display Large Meters feature is particularly useful when looking at the computer screen from a distance
while “Cruising” or manually adjusting the Blower Door fan in Idle-Monitoring  mode.  The Real-Time
ACH50 Status Window is only active when the current building pressure is between 40 and 60 Pascals, and
a valid fan flow measurement is being made.  The Real-Time ACH50 display is not active during an
automated test sequence.

Display Large Meters Feature

  Ring  A
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Chapter 8     Using the Manual Data Entry Method

8.1  Overview of Test Graph Screen (Manual Method)

Manual Method is used to input Blower Door test data (e.g. building pressure and fan flow readings) that
were collected manually, rather than collected automatically by TECTITE.  The Manual Method  option is
only available if the Method field is set to Manual from the Test Settings Screen

The figure below shows the Test Graph Screen when using Manual Method.  Like the Auto Method Test
Graph Screen, the main feature of the Manual Method Test Graph Screen is a plot of Blower Door fan flow
(or building leakage) on the vertical axis versus building pressure on the horizontal axis.  However, when
using Manual Method, all auto control buttons and status windows have been removed, and replaced with a
Data Table button which opens a simple data entry table.  Test data (i.e. fan and building pressure
measurements) entered into the Data Table are plotted on the graph, and a best-fit regression line is
automatically drawn through the plotted data points.

Test Graph Screen (Manual Method)

8.2  Selecting the Fan Model

Before entering data into the Data Table, select the Blower Door fan model being used for the test.  To
select the fan model, click on Options located in the Main TECTITE Menu.  From the Options Menu,
select Fan Info.  In the Fan Information window, select the appropriate fan model (or type), and then click
on OK.  You may also input a fan serial number which will be stored along with the building test file, and is
printed out on the detailed test report.  Importantly, if you change the selected fan model while test data are
displayed on the graph, the test data will be automatically cleared from the graph and the Data Table.

Button to access manual
entry Data Table.

Selected Fan Model
and Test Mode.

Pressure difference between inside
and outside (Building Pressure)

Flow through the
Blower Door fan
(Building
Leakage)
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Fan Information Window

8.3  Entering Test Data into the Data Table

To manually enter test data, first click on the Data Table button from the Test Graph Screen.  The Data
Table which appears allows entry of up to 10 sets of Blower Door test readings (arranged in rows), plus one
Pre-Test Baseline reading, and one Post-Test Baseline reading.  The use of baseline pressure readings in the
Table allows the program to quickly adjust the manually collected test data for baseline stack and wind
effects. You can move through the Table using the Tab key, or by clicking on the individual entry fields

Data Table for Manual Entry of Test Readings

To begin data entry, you must first input a Pre-Test Baseline reading in Pa. Once a Pre-Test Baseline
reading has been entered, you may input as few as 1 and as many as 10 sets of test readings.  For each set of
test readings, you must enter the measured building pressure (in Pa), the fan configuration corresponding to
this set of readings (i.e. which Flow Ring was installed on the fan), and the measured fan flow used to
generate the building pressure.  Fan flow can either be entered directly in CFM (by choosing the Flow
button in the Flow Data Source field), or by entering the fan pressure signal in Pascals (by choosing the Fan
Pressure button in the Flow Data Source field).  If you enter the fan pressure signal, the
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flow value will be automatically determined by TECTITE.  If you input fewer than 10 sets of readings,
simply leave the remaining rows empty.

The Post-Test Baseline reading is an optional field for those who wish to take a second baseline building
pressure reading following completion of the airtightness test.  If you input a Post-Test Baseline reading, the
program will use the average of the Pre and Post Baseline readings in its analysis.  If you leave the Post-
Test Baseline reading field empty, the program will simply use the Pre-Test reading when adjusting for
baseline pressure effects.

When you are finished entering test data into the Table, click on OK to return to the Test Graph.  You can
clear the Table at any time by clicking on the Clear Data button

8.4  Tips on Using a DG-700 Gauge with the Data Table

�  Be sure you have the gauge set up properly (refer to your Blower Door or digital gauge manual).
�  If you are using the DG-700’s Baseline feature, enter 0 into the Baseline fields (you may leave the

Post-Test Baseline field blank).  This is because the DG-700’s Baseline feature has already
adjusted the building pressure reading(s) for baseline effects.

�  If you are using the DG-700’s @50 feature to conduct a one-point Blower Door test, always enter
the building pressure as 50 Pa.  This is because the @50 feature automatically adjusts the
displayed flow reading to a test pressure of 50 Pa.

�  If you take and enter a Pre-Test Baseline reading, be sure to include the proper sign of the reading.
�  If you are Depressurizing the building, enter the Building Pressure readings as negative numbers

(TECTITE automatically places a negative sign in the Building Pressure entry fields if the Test
Mode is set to DEPRESSURIZE).

�  If you are Pressurizing the building, enter the Building Pressure readings as positive readings.
�  Fan pressure readings can be entered as positive or negative readings.
�  If you choose to take and enter a Post-Test Baseline reading, be sure to include the proper sign of

the reading.

8.5  Tips on Using a DG-3 Gauge with the Data Table

�  Be sure you have the gauge set up properly (refer to your Blower Door or digital gauge manual).
�  Always take a Pre-Test Baseline pressure reading and enter it into the Data Table.  Be sure to keep

track of the proper sign (+ or -) of the baseline reading.
�  If you are Depressurizing the building, enter the Building Pressure readings as negative numbers

(TECTITE automatically places a negative sign in the Building Pressure entry fields if the Test
Mode is set to DEPRESSURIZE).

�  If you are Pressurizing the building, enter the Building Pressure readings as positive readings.
�  Fan pressure readings can be entered as positive or negative readings.
�  If you choose to take and enter a Post-Test Baseline reading, be sure to include the proper sign of

the reading.
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8.6  Tips on Using Magnehelic Gauges with the Data Table

�  Be sure you have the gauges set up properly (refer to your Blower Door manual).
�  Always zero the gauges prior to starting the test using the instructions contained in your Blower

Door manual.
�  Always enter 0 into the Baseline fields (you may leave the Post-Test Baseline field blank).  This is

because zeroing the 60 Pa building pressure gauge adjusts the building pressure reading(s) for
baseline effects.

�  If you are Depressurizing the building, enter the Building Pressure readings as negative numbers
(TECTITE automatically places a negative sign in the Building Pressure entry fields if the Test
Mode is set to DEPRESSURIZE).

�  If you are Pressurizing the building, enter the Building Pressure readings as positive readings.
�  Fan pressure readings can be entered as positive or negative readings.
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Chapter 9    Viewing Test Results

Once an automated test has been completed, or test data have been manually entered into the Data Table,
test results are automatically calculated using all data points displayed on the graph, and values input into
the building and climate screens.  To view the Test Results Screen, click on Next from either Test Graph
Screen.

Test Results Screen

Note:   If you are conducting an automated test, and are measuring zone pressures during the Blower Door
test, a Next button will appear at the bottom of the Test Results Screen.  Clicking on the Next button will
take you to the Zone Data Screen, which is discussed in more detail in Chapter 10.

9.1  Overview of Test Results Screen

Airflow At 50 Pascals:

CFM50:  This is the airflow (in Cubic Feet per Minute) needed to create a change in building
pressure of 50 Pascals.  CFM50 is the most commonly used measure of building airtightness.

ACH at 50 Pa:  The Air Changes per Hour (ACH at 50 Pa) is another commonly used measure of
building airtightness.  ACH at 50 Pa is the number of complete air changes that will occur in one
hour with a 50 Pascal pressure being applied uniformly across the building envelope.  ACH at 50
Pa is a useful method of adjusting (or normalizing) the leakage rate by the size (volume) of the
building.  If you did not enter the building volume on the Building Information screen, ACH50
will not be calculated.

�  ACH at 50 Pa   =    (CFM50 x 60) / building volume in cubic feet

CFM50/square foot of floor area:  This is the CFM50 reading for the building divided by the
floor area of the building.  CFM50/square foot adjusts (or normalizes) the leakage rate by the size
(floor area) of the building.  If you did not enter the floor area on the Building Information screen,
this variable will not be calculated.

�  CFM50/square foot  =  CFM50 / floor area in square feet
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CFM50/square foot of surface area (MLR):  Also known as the Minneapolis Leakage Ratio
(MLR), this is the measured CFM50 divided by the above grade surface area of the building.
MLR is a useful method of adjusting (or normalizing) the leakage rate by the amount of envelope
surface through which air leakage can occur.  The MLR has been particularly useful for
weatherization crews working on wood frame buildings.  Experience to date has shown that for
buildings with a MLR above 1.0, very large cost-effective reductions in infiltration can often be
achieved using Blower Door guided infiltration and insulation techniques.  In buildings with a
calculated MLR in the 0.5 to 1.0 range, it is often more difficult to achieve economical
improvements in airtightness.  If you did not enter an Above Grade Surface Area value into the
Building Information screen, MLR will not be calculated.

�  MLR  =  CFM50 / above grade surface area in square feet

Leakage Areas:

Once the leakage rate for the building has been measured, it is useful to estimate the cumulative size (in
square inches) of all leaks or holes in the building's air barrier.  The estimated leakage areas not only
provide us with a way to visualize the physical size of the measured holes in the building, but they are also
used in infiltration models to estimate the building's natural air change rate.

The Test Results Screen includes two leakage area calculations, based on differing assumptions about the
physical shape of the hole, which are compatible with the two most commonly used infiltration models.

Equivalent Leakage Area (EqLA):  EqLA is defined by Canadian researchers at the Canadian
National Research Council as the area of a sharp edged orifice (a sharp round hole cut in a thin
plate) that would leak the same amount of air as the building does at a pressure of 10 Pascals.  The
EqLA is used in the AIM infiltration model (which is used in the HOT2000 simulation program).

Effective Leakage Area (ELA):  ELA was developed by Lawrence Berkeley Laboratory (LBL)
and is used in their infiltration model.  The Effective Leakage Area is defined as the area of a
special nozzle-shaped hole (similar to the inlet of your Blower Door fan) that would leak the same
amount of air as the building does at a pressure of 4 Pascals.

Note on Leakage Areas:

When using leakage area calculations to demonstrate physical changes in building airtightness, we
recommend using the EqLA measurement.  Typically, EqLA more closely approximates physical
changes in building airtightness.  For example, if you performed a Blower Door test, and then
opened a window to create a 50 square inch hole and repeated the test, the estimated EqLA for the
building will have increased by approximately 50 square inches from the initial test results.

Building Leakage Curve:

Coefficient (C) and Exponent (n):  Once an automated airtightness test sequence (or manual
entry of data into the table) has been completed, a "best-fit" line (called the Building Leakage
Curve) is drawn through the collected Blower Door data.  The Building Leakage Curve can be
used to estimate the leakage rate of the building at any pressure.  If you have conducted a single
point test, the program assumes an exponent (n) of 0.65 in its calculation procedures.3

                                                
3   The assumed exponent value of 0.65 is based on the average observed exponent for a large sample of  residential
Blower Door tests.
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The Building Leakage Curve is defined by the variables Coefficient (C) and Exponent (n) in the
following equation:

Q = C x Pn

where:
Q  is airflow into the building (in CFM).
C  is the Coefficient.
P  is the pressure difference between inside and outside of the building.
n  is the Exponent.

Example:  Use the Building Leakage Curve to estimate the exhaust fan airflow in a
building needed to create a 5 Pa negative pressure.  From our Blower Door test we
determined the following Building Leakage Curve variables.

C = 110.2   n = 0.702    From the equation above:

Airflow (at 5 Pa) =  110.2 x 5^.702  =  341 CFM.  In other words, we estimate from
the Building Leakage Curve that it would take exhaust fans with a combined capacity
of 340 CFM to cause a 5 Pa pressure change in this building.

Correlation Coefficient:  The correlation coefficient is a measure of how well the collected
Blower Door data fit onto the "best-fit" Building Leakage Curve.  The closer all data points are to
being exactly on the Building Leakage Curve, the larger the calculated correlation coefficient
(note:  the largest possible value for the correlation coefficient is 1.0).  Under most operating
conditions, the correlation coefficient will be at least 0.99 or higher.

Estimated Annual Infiltration:

Estimating the natural infiltration rate of a building is an important step in evaluating indoor air  quality and
the possible need for mechanical ventilation.  Blower Doors do not directly measure the natural infiltration
rates of buildings.  Rather, they measure the building leakage rate at pressures significantly greater than
those normally generated by natural forces (i.e. wind and stack effect).  Blower Door measurements are
taken at higher pressures because these measurements are highly repeatable and are less subject to large
variations due to changes in wind speed and direction.

In essence, a Blower Door test measures the cumulative hole size, or leakage area, in the building's air
barrier (see Leakage Areas above).  From this measurement of leakage area, estimates of natural
infiltration rates can be made using mathematical infiltration models.  The TECTITE program uses the
calculation procedure contained in ASHRAE Standard 136-1993 to estimate the average annual natural
infiltration rate for purposes of evaluating indoor air quality and the need for mechanical ventilation.

CFM, ACH and CFM/person:  The estimated annual natural infiltration rate (based on ASHRAE
Standard 136-1993) is expressed in Cubic Feet per Minute (CFM), Air Changes Per Hour (ACH),
and CFM per person.  When determining occupancy for the CFM/person calculation, the program
uses the number of bedrooms plus one, or the number of occupants, whichever is greater.

Notes on Estimated Annual Infiltration Rates:

�  Daily and seasonal naturally occurring air change rates will vary dramatically from the
estimated average annual rate calculated here due to changes in weather conditions (i.e. wind
and outside temperature).
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�  The physical location of the holes in the building air barrier compared to the assumptions used
in the infiltration model will cause actual annual infiltration rates to vary from the estimated
values.  Research done in the Pacific Northwest on a large sample of houses suggests that
estimated infiltration rates for an individual house (based on a Blower Door test) may vary by
as much as a factor of two or more when compared to PFT tracer gas tests.  (PFT tracer gas
tests are one of the most accurate methods of measuring actual natural infiltration rates.)

�  The annual average infiltration estimates from ASHRAE Standard 136-1993 should be used
only for evaluating detached single-family dwellings, and are not appropriate for use in
estimating peak pollutant levels or energy loss due to infiltration.  If any of the building
leakage is located in the forced air distribution system, actual air leakage rates may be much
greater than the estimates provided here.  Duct leaks result in much greater air leakage
because they are subjected to much higher pressures than typical building leaks.

Estimated Design Infiltration:

In addition to estimating an annual infiltration rate above, the program estimates the design winter
and summer infiltration rates for the building.  The design infiltration rates are the infiltration rates
used to calculate winter and summer peak loads for purposes of sizing heating and cooling equipment.  The
calculated design infiltration rates can be used in ACCA Manual J load calculations in lieu of the estimation
procedures listed in Manual J.  The estimation procedure uses the design wind speed and temperature
difference values input into the Climate Information Screen, and are based on the calculation procedures
listed in the ASHRAE Fundamentals Handbook, Chapter on Infiltration and Ventilation.

Winter and Summer:  CFM, ACH:   The estimated design infiltration rates are expressed in
Cubic Feet per Minute (CFM), and Air Changes per Hour (ACH).

Mechanical Ventilation Guideline:

It is possible, even easy in the case of new construction or when air sealing work is done by trained skilled
contractors, to increase the airtightness of a house to the point where natural air change rates (from air
leakage) may not provide adequate ventilation rates to maintain acceptable indoor air quality.  To help
evaluate the need for mechanical ventilation in buildings, national ventilation guidelines have been
established by ASHRAE.  The recommended whole building mechanical ventilation rate presented in this
version of TECTITE is based on ASHRAE Standard 62.2 and is only appropriate for low-rise residential
structures.

Recommended Whole Building Mechanical Ventilation Rate: This value is the recommended
whole building ventilation rate to be supplied on a continuous basis using a mechanical ventilation
system.  The recommended mechanical ventilation rate is based on 7.5 CFM per person (or
number of bedrooms plus one – whichever is greater), plus 1 CFM per 100 square feet of floor
area.  This guideline assumes that in addition to the mechanical ventilation, natural infiltration is
providing 2 CFM per 100 square feet of floor area..

For buildings where the estimated annual natural infiltration rate (based on the Blower Door test)
is greater than 2 CFM per 100 square feet of floor area, the recommended mechanical ventilation
rate is reduced to provide ventilation credit for excess infiltration.  In these cases, the
recommended mechanical ventilation rate is reduced by the following amount:

0.5 x (estimated annual natural infiltration rate (CFM) –  0.02 CFM x sq. ft. of floor area )



Chapter 9   Viewing Test Results

TECTITE
Version 3.2

40

Notes on Ventilation Guidelines:

�  ASHRAE Standard 62.2 also contains requirements for local kitchen and bathroom
mechanical exhaust systems.  These local exhaust systems may be incorporated into a whole
building ventilation strategy.  Consult Standard 62.2 for more information on ventilation
strategies and specific requirements and exceptions contained in the Standard.

�  Compliance with the ventilation guideline does not guarantee that a moisture or indoor air
quality (IAQ) problem will not develop.  Many factors contribute to indoor air quality
including ventilation rates, sources and locations of pollutants, and occupant behavior.
Additional testing (including combustion safety testing) is needed to fully evaluate air quality
in buildings.  In many cases, a combination of pollutant source control and mechanical
ventilation will be required in order to ensure adequate indoor air quality.

�  Previous versions of TECTITE used ASHRAE Standard 62-1989 to determine an annual
ventilation guideline.  The Standard 62-1989 guideline (which was superceded by Standard
62.2) was based on 15 CFM per person or 0.35 Air Changes per Hour (whichever was
greater).

Estimated Cost of Air Leakage:

The program estimates the annual cost associated with air leakage, both for heating and cooling.
The equations used to calculate the annual cost for air leakage are:

    Annual          26 x HDD x Fuel Price x CFM50
     Heating  =      --------------------------------------     x  0.6

Cost                    N x Seasonal Efficiency

- HDD is the annual base 65 F heating degree days for  the building location.
- The Fuel Price is the cost of fuel in dollars per Btu.
- N is the Energy Climate Factor from the Climate Information Screen (adjusted for wind
  shielding and building height).  See Appendix E of the Model 3 Blower Door Operation

   Manual for more information on this calculation procedure.
- Seasonal Efficiency is the AFUE rating of the heating system.

     Annual          .026 x CDD x Fuel Price x CFM50
     Cooling   =     ----------------------------------------
     Cost                              N x SEER

- CDD is the base 70 F cooling degree days for the building location.
- The Fuel Price is the cost of electricity in  dollars per kwh.
- N is the Energy Climate Factor from the Climate Screen (adjusted for wind shielding and
  building height).  See Appendix E of the Model 3 Blower Door Operation Manual for more
  information on this calculation procedure.
- SEER is the SEER rating for the air conditioner.

Note:  Cooling Cost procedure is based on sensible loads only.  In hot humid climates, latent 
loads due to air leakage can be greater than the sensible loads which are estimated by this 
procedure.
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Chapter 10    Measuring Building Zone Pressur es

Many important air leaks in a building are not direct leaks to the outside.  Indirect air leaks, or “series
leaks”, often follow complicated paths through building cavities and through unconditioned zones  (such as
attics, crawlspaces or garages) on their way into or out of the building.  Attic bypasses are a good example
of a series leak.  Air leaving the house first must flow through the ceiling/attic boundary and then through
the attic/roof boundary before exiting the house.

Diagnostic procedures have recently been developed to help analyze series leakage paths in buildings.
These diagnostic procedures, usually called pressure diagnostics, combine standard Blower Door
airtightness tests with building zone pressure measurements to help prioritize airsealing activities.  The
TECTITE program can be used to automate the measurement of building zone pressures during a building
airtightness test.  The zone pressure test results can then be used directly as a performance measurement, or
as inputs into a separate series leakage analysis program such as the ZPD Calculation Utility program
available at no charge from The Energy Conservatory website (www.energyconservatory.com).

10.1  Using the Zonal Pressure Measurement Feature

In order to make use of  TECTITE’s  zonal pressure measurement feature, you must have an APT DAB
with 3 or more installed pressure channels.  During an automated airtightness test channels P1 and P2 are
used to measure building pressure and fan flow respectively.  Installed channels P3 through P8 can be used
to measure zonal pressures during the airtightness test.

To activate the zonal pressure feature, first click on the Active button in the Zonal Pressures field on the
Test Settings Screen.  Now click on the Settings button to bring up the Zonal Pressures Set-Up Screen.

Zonal Pressures Set-Up Screen

From this screen you can configure TECTITE to measure zonal pressures during the automated airtightness
test.  For each installed pressure channel that you want to use, click on the appropriate check box under
“Activate”.  Edit the corresponding Zone Name field with a descriptive label for the zone being measured.
Now choose the reference pressure location for that zone in the “With Reference To” field.
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When choosing the reference pressure location for a zone, we recommend that you choose “outside” if the
zone being measured is intended to be better connected to the outside (such as in the case of a vented attic,
or a garage), or choose inside if the zone is intended to be better connected to the inside (such as in the case
of most basements).

The information that you have entered on the Zonal Pressure Set-Up Screen will be stored when you save a
test file or a configuration file.  You may wish to make zonal pressure set-up part of your default
configuration file (see Chapter 14 for information on creating and using configuration files).  Once you
have completed the Zonal Pressure Set-Up Screen, click on OK to return to the Test Settings Screen.

10.2  Connecting Tubing to the DAB for Zone Pressure Measurements

After the Zonal Pressure Set-Up Screen has been completed, you will need to run tubing between the DAB
and the zones to be tested.  The first step is to connect tubing between the zone and the appropriate Input
tap on the DAB.  For example, if you have designated P3 to measure attic pressure, connect tubing from the
attic space to the P3 Input tap.  You will now need to connect the Reference pressure tap for each zone
channel to the reference space that you have designated in the Zonal Pressure Set-Up Screen (i.e. outside or
inside).  For example, if you have set up Channel P3 to measure attic pressure with reference to outside, you
will need to connect the P3 Reference tap to tubing running outside.

Connecting Tubing to the DAB for Zone Testing

Note:   If more than 1 channel is being referenced to the outside, run a single piece of tubing to the outside
and use “T” connectors (along with short pieces of tubing) to connect the outside tubing to multiple
reference pressure taps.

Connect Input taps to zone spaces.

INPUT

REF
P1 P2 P3 P4 P5 P6 P7 P8

Connect Reference taps to reference location
designated in Zonal Pressure Set-Up Screen.
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10.3  Taking and Storing Zone Pressure Measurements

Once the Zonal Pressures feature has been activated and the Set-Up Screen completed, the zone pressure
status windows will appear at the top of the Test Graph (Auto Method) Screen.  Operating status windows
will only appear for installed pressure channels that have been activated in the Set-Up Screen.

Zone Pressure Status Windows

To begin taking zone pressure measurements, you must initiate an airtightness test sequence by clicking on
the Start Test button.  Zone pressure measurements, including baseline zone pressures, are taken at the
same time that TECTITE is collecting building pressure and fan flow measurements for the airtightness test.
For example, if you are conducting a standard CGSB airtightness test procedure at 8 separate target
building pressures, TECTITE will collect 8 sets of zone pressure measurements, along with a pre-test and
post-test baseline measurement.  The number of samples taken at each target pressure for the zone pressure
channels is determined by the Samples Per Station field on the Test Setting Screen.

Note:  Zonal pressures displayed in the status windows are adjusted for their current baseline zone pressure
readings.  During a test sequence, numbers only appear in the zone pressure status windows during data
sampling.

10.4  Viewing Zone Data

Once the automated Blower Door test is completed, the measured zone data are shown on the Zone Data
Screen.  To view the Zone Data Screen, click on Next from the Test Results Screen, or choose Zone Data
from the Goto Menu.

  Ri ng  A

Attic Crawlspa Garage
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Zone Data Screen

10.5  Overview of Zone Data Screen

The left side of the Zone Data Screen contains a graph of measured zonal pressure (y-axis) versus house
pressure (x-axis).  The pressure data points shown on the graph are not adjusted for measured baseline
zones pressures, and the baseline pressure measurements themselves are included on the graph.  Each data
point shown on the graph is an average of all samples taken for that zone at a particular target building
pressure.  Data for an individual zone can be temporarily removed from the graph by clicking on the zone
name or the check box next to the name.  The graph is automatically re-scaled to accommodate all active
zone channels.

The columns to the right of the graph provide summary data for each zone.  The summary data can be used
directly as a performance measurement, or as inputs into a separate series leakage analysis program.

�  House to Zone @ 50 Pa:   This is the estimated change in house to zone pressure (in Pascals)
that would occur when the house to outside pressure is changed by 50 Pascals, based on a
linear relationship between house pressure and zone pressure.

�  Zone to Outside @ 50 Pa:   This is the estimated change in zone to outside pressure (in
Pascals) that would occur when the house to outside pressure is changed by 50 Pascals, based
on a linear relationship between house pressure and zone pressure.

�  +/-:   The third numerical column is the estimated repeatability of the House to Zone @ 50
Pa, and the Zone to Outside @ 50 Pa estimates.  If you were to repeat this test under the
same building setup and weather conditions, the new results would not likely differ by more
than the estimated repeatability.

+/-
Zone

Pressure

+/-
Pressure

Ratio

Attic – P3

Crawlspace – P4

Garage – P5
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�  Pressure Ratio:   This is the Zone to Outside @ 50 Pa estimate divided by 50.  The Pressure
Ratio will almost always be a number between 0 and 1.   If the Pressure Ratio is between 0.0
and 0.5, then the zone being measured is better connected to outside than inside.  If the
Pressure Ratio is between 0.5 and 1.0, then the zone being measured is better connected to
inside than outside.  As a simple memory aid:  remember that “0 = Outside” and “1 = Inside”.

Example Pressure Ratios

�  +/-:   The fifth numerical column is the estimated repeatability of the Pressure Ratio.   If you
were to repeat this test under the same building setup and weather conditions, the new
Pressure Ratio would not likely differ by more than the estimated repeatability.

Note:   If you have set up the pressure hoses to your DAB correctly, the House to Zone @ 50 and
Zone to Outside at 50 estimates will almost always appear as positive numbers, whether you are
depressurizing or pressurizing the building.  If these estimates appear as negative numbers, you
have probably connected the hoses incorrectly, or have designated the wrong reference location in
the Zone Pressure Set-Up Screen.

10.6  ZPD Input Table

If you are using The Energy Conservatory’s ZPD Calculation Utility program to estimate air leakage rates
from zones monitored during an automated Blower Door test, the ZPD Input Table contains all of the test
data required to be input into the calculation utility program.  The ZPD Input Table can be found at the end
of the Zone Data Report which is available from the main File menu (see Chapter 12  Printing Test
Reports for more information).  The ZPD Input Table is not contained on the Zone Data Screen.

House to Zone @ 50 Pa Zone to Outside @ 50 Pa Pressure Ratio
50 0      0.00 (zone is outside)
49 1      0.02
45 5      0.10
40 10      0.20
30 20      0.40
25 25      0.50
20 30      0.60
10 40      0.80
5 45      0.90
1 49      0.98
0 50      1.00 (zone is inside)
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Chapter 11     Saving and Retrieving Building Test Files

11.1  Saving Building Test Files

Test files can be saved at any time by selecting File from the Main TECTITE Menu, and then clicking on
Save Current Test File which appears in the File Menu.

Saved building test files contain all information entered into the Customer, Building, Climate, Comments
and Test Settings Screens, as well as all test data shown on the Graph and Zone Data Screens.  When saving
a test file, you will need to enter a file name in the file saving browser that appears on screen.  You may also
choose a different destination folder for the saved file by clicking on the Save in window.  Once you have
chosen a file name and destination, click on Save.

Saving File Browser

Note:  All building test files are automatically given a .bld extension.

11.2  Retrieving Building Test Files

To retrieve a previously saved building test file for viewing, editing or printing, first select File from the
Main TECTITE Menu, and then click on Retrieve Existing Test which appears in the File Menu.
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After selecting the “Retrieve” option, a file browser will appear on screen which lists all the building (.bld)
files contained in the default folder.  To select a file, click on the file name from the list and then click on
Open.  Once the file has been selected, the file information is loaded into the TECTITE program and the
Customer Screen appears.  To change the folder being listed, click on the Look in window.

Retrieving File Browser

11.3  Retrieving a Previous Test as the Starting Point for a New Test

If you want to perform a repeat test at a building that you have previously tested, it is very convenient to
start by retrieving the old test.  Choose Retrieve Existing Test from the File menu and select the old
building test file.  As you go through the data entry screens, check for any information that has changed
since the old test was performed.

Importantly, when you get to the Test Graph screen click on the Clear Data button.  This clears the Blower
Door test data (including zone pressure data) so that you can perform a new airtightness test.  Use of the
Clear Data button will not affect the original building test file stored on your computer.  When you are
done, save your new test using a new file name.

Manual Method Users:

When using the Manual data entry method, the data on the graph can be cleared by clicking on the Clear
Data button from the Data Table window.

11.4  Format of Saved Building Files

All building test files (.bld) are space delimited ASCII text files.  The format for saved building files is
shown below.
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Format of Saved Test Files

TECTITE Version:
Flow_Units:
Building Dimension_Units:
Leakage_Dimension_Units:
Temperature_Units:
Serial_Number:
Last_Calibration_Date:
Pr_Channels:
Device_Type:  (1=APT, 2=DG-700)
DAB Calibration Parameters:
   (depends on Device Type)

Test_Date: 7-31-97
Technician: Bill Smith
Name: Jim Darby
Address: 1507 Center Ave.
Address_Line2:
City: Wheaton
State: IL
Zip: 60187
Phone: 708-668-8469
Fax:
Building_Address:
Building_Address_Line2:
Building_City:
Building_State:
Building_Zip:
Volume: 28500
Floor: 2400
Surface: 1850
Stories: 2
Bedrooms: 4
Occupants: 4
Windshield: L
Heat_Fuel: G
Heat_Cost: 0.85
Heat_Eff: 92
Cool_Cost: 0.13
SEER: 12
Gas: ccf 0.85 92
Propane: gallon
Electric: gallon
Oil: kwh
Wood: cord
Coal: ton
Heat Pump: kwh

DAB Parameters

Customer Info

Building Info

Software Version
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Inside_Temp: 70
Outside_Temp: 85
Heat_Degree_Day: 6155
Cool_Degree_day: 430
Energy_Climate_Factor: 18
Vent_Climate_Factor: 0.93
Design_Winter_Temp_Diff: 71
Design_Summer_Temp_Diff: 15
Design_Winter_Wind_Speed: 12
Design_Summer_Wind_Speed: 7
Location_Climate_Data:
Business: Smith and Sons Heating
B_Address: 5678 Main St.
B_Address_Line2:
B_City: Wheaton
B_State: IL
B_Zip: 60187
B_Phone: 708-222-5555
B_Fax
Comments: Owner complains of excess humidity in winter.
Downspouts dump right at base of foundation .
2 smokers.
Build_Press_#1:
Build_Press_#2:
Build_Press_#3:
Build_Press_#4:
Build_Press_#5:
Build_Press_#6:
Build_Press_#7:
Build_Press_#8:
Build_Press_#9:
Build_Press_#10:
Manual_Entry_Rows: 10
Manual_Entry_Data_0: -1 1.0 0.0 0.0
Manual_Entry_Data_1: 1 -52 272 2895
Manual_Entry_Data_2: 1 -45 240 2721
Manual_Entry_Data_3: 1 -39 208 2535
Manual_Entry_Data_4: 1 -30 165 2260
Manual_Entry_Data_5: 1 -25 135 2047
Manual_Entry_Data_6: 1 -20 109 1841
Manual_Entry_Data_11: -1 0 0.0 0.0
Build_Test_Mode: D
Build_Standard: C
Build_Test_Method: M
Target_Tolerance: 2.0
Fan_adjust: 0.5
Data_samples: 100
Building_High_Pressure_Limit: 80
Zonal_Pressures_Active:
Zone3_Active:
Zone3_Name:
Zone3_Reference:
Zone4_Active:
Zone4_Name:
Zone4_Reference:
(repeats through Zone8)

Climate Info

Comments
Info

Target Building Pressures (Auto Method-Custom Pressures)

 Data Table Entries
(Manual Method)

Test Settings

Business Info
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Station_count: 8
Complete_test: 1
Data_pt_0: -1 0.000000 1.000000 0.000000 0.000000 0.000000 0.000000
Data_pt_1: 1 -52.000000 -52.000000  272.000000 2895.000000 0.000000 0.000000
Data_pt_2: 1 -45.000000 -45.000000  240.000000 2721.000000 0.000000 0.000000
Data_pt_3: 1 -39.000000 -39.000000  208.000000 2535.000000 0.000000 0.000000                         Test Data4
Data_pt_4: 1 -30.000000 -30.000000  165.000000 2260.000000 0.000000 0.000000
Data_pt_5: 1 -25.000000 -25.000000  135.000000 2047.000000 0.000000 0.000000
Data_pt_6: 1 -20.000000 -20.000000  109.000000 1841.000000 0.000000 0.000000
Data_pt_7: -1 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
Q50: 2879.024082
Q50_err: 0.322922
ACH50: 6.061103
ACH50_err: 0.000011
Q50_sq.ft.: 1.199593
EOA50: 378.407409
EOA50_err: 0.042444
EqLA: 390.747088
EqLA_err: 1.029979
ELA: 242.780169
ELA_err: 1.716245
MLR: 1.556229
C: 440.183579
C_err: 2.764983
n: 0.480062
n_err: 0.007609
r: 0.999498
Est_Nat_CFM: 382.054248
Est_Nat_ACH: 0.804325
Est_Nat_CFM_Occ: 76.410850
Min_CFM_Mech: 166.250000
Winter_Des_CFM: 483.413055
Winter_Des_ACH: 1.017712
Summer_Des_CFM: 250.240293
Summer_Des_ACH: 0.526822
Est_Heat_Cost_Year: 187.097373
Est_Cool_Cost_Year: 25.543938

                                                
4   Columns from left to right:  Fan Configuration (-1 = baseline reading), Target Building Pressure, Building Pressure
Reading (*  for auto test, the average of all samples collected at the target pressure), Fan Pressure Reading (* for auto
test, the average of all samples collected at the target pressure), Calculated Flow in CFM (* for auto test,  the average of
all samples collected at the target pressure), Standard Deviation of the Building Pressure Reading, Standard Deviation
of the Fan Flow Reading, (if Zonal Pressures Active)  Zone 3 Pressure Reading, Standard Deviation of Zone 3 Pressure
Reading, Zone 4 Pressure Reading, Standardard Deviation of Zone 4 Pressure Reading (repeats through Zone 8).

Calculated Test Results
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Build_Fan_Model: 3
Model3_Serial_Number:
DuctBlasterA_Serial_Number:
DuctBlasterB_Serial_Number:
Fan_Calib_Model3_Ring0: 490.2 0.4945
Fan_Calib_Model3_Ring1: 180.7 0.4948
Fan_Calib_Model3_Ring2: 57.2 0.5065
Fan_Calib_Model3_Ring3: 22.34 0.5048
Fan_Calib_Model3_Ring4: 7.596 0.4927
Fan_Calib_Model3_Ring5: 3.041 0.5016
Fan_Calib_DBA_Ring0: 104.38 0.5
Fan_Calib_DBA_Ring1: 39.25 0.5
Fan_Calib_DBA_Ring2: 15.31 0.5
Fan_Calib_DBA_Ring3: 6.26 0.5
Fan_Calib_DBA_Ring4: 0 0
Fan_Calib_DBA_Ring5: 0 0
Fan_Calib_DBB_Ring0: 108.5 0.5
Fan_Calib_DBB_Ring1: 41.42 0.5
Fan_Calib_DBB_Ring2: 15.8 0.5
Fan_Calib_DBB_Ring3: 6.33 0.5
Fan_Calib_DBB_Ring4: 0 0
Fan_Calib_DBB_Ring5: 0 0

Fan Info
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Chapter 12     Printing Test Reports

12.1  Printing and Preview Options

Report printing and previewing options are available by clicking on File in the Main Menu.

The TECTITE program includes a choice of three pre-formatted reports: a 1 page Customer Report, a 3
page Detailed Report and a 1 page Zone Data Report.  In addition, the airtightness Test Graph can be
printed separately.  Note:  The actual length of the Detailed Report and Zone Data Report depends on the
number of data points collected during the test.

The Customer Report contains the basic building airtightness test results and a simplified description of
how to interpret the test results.  Detailed Reports contain a complete listing of the building airtightness data
and results, as well as any comments input into the Comment Screen.  The Zone Data Report contains a
listing of all measured zone pressures and estimated building to zone and zone to outside pressures at 50
Pascals of building pressure, as well as a graph of zone pressures versus building pressures. In addition, the
end of the Zone Data Report includes a ZPD Input Table which contains test data which can be directly
input into The Energy Conservatory’s ZPD Calculation Utility program used to estimate the leakage rate of
monitored zones.

The Test Graph is similar to the graph of fan flow (or leakage) vs. building pressure from the Test Graph
Screen.  It can be used to visually estimate the relationship between air leakage and  building pressure.

The printing and preview functions within TECTITE utilize the Windows printer drivers and configuration
options currently installed in your computer.

12.2  Putting Your Business Name and Logo at the Top of the Reports

The name, address and phone number for your business can be placed at the top of the first page of all
printed reports by completing the Business Info window.  To access the Business Info window, click on
Options in the Main Menu, and then click on Business Info from the Options Menu.  Information entered
in the Business Info window is saved as part of the data files.
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Business Information Window

To insert a logo at the top of the printed reports, simply place an electronic image of your logo in the
working directory of the TECTITE program.  The image file must be named “reportlogo”, and the file
format must be either a Windows Bitmap File (.bmp extension)  or a Windows Enhanced Meta File (.emf
extension).  The default working directory for TECTITE Ver. 3.2 is  C:\Program Files\Energy
Conservatory\TECTITE 3.2.  If you chose a custom install directory for TECTITE during program
installation, you will need to place the image file in that directory.

If a reportlogo.bmp or reportlogo.emf file is found by TECTITE, the image is automatically placed in the
upper left hand corner of the printed reports.  The image is placed in a  2” wide by 1” high box, and
TECTITE sizes the image (using its saved aspect ratio) to maximize its size within the box.  Because
TECTITE uses a 2” wide by 1” high image box, images saved with a 2 to 1 width to height ratio will
completely fill the image box.  Images saved with any other aspect ratio will completely fill the image box
in only one dimension.

Top of Customer Report with Business Name and Logo

Figure 14.3:  Sample Customer Report

Figure 14.3:   Sample Detailed Report

BUILDING LEAKAGE TEST (Detailed  Report)      Page 2

       Date of Test:  7-31-97    Test File:  darby1

Logo Image Box
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Sample Customer Report (without logo)
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Sample Detailed Report (without logo)

Recommended Whole Building Mechanical                 7.8 CFM
Ventilation Rate: (based on ASHRAE 62.2-2003)
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The data table on Page 3 contains the following information:
 

�  Nominal Building Pressure:  Building pressure measurements for each target pressure at which
sampling was conducted, including the pre and post test baseline measurements. Baseline building
pressure measurements correspond to Fan Pressure readings of “n/a”.  Building pressure data are
not adjusted for measured baseline pressures.

 
�  Fan Pressure:  Fan pressure measurements for each target pressure at which sampling was

conducted.
 

�  Nominal Flow (CFM):   Calculated air flow through the Blower Door fan, based on the measured
fan pressure and the calibration formula for the fan.

 
�  Temperature Adjusted Flow (CFM):  Calculated air flows through the fan are adjusted for

differences in air density due to temperature.  The TECTITE program makes the following air
density adjustments in accordance with CGSB Standard 149.10-M86.
 
 Depressurization Test:
 
 Adjusted Flow (CFM) = Nominal Fan Flow  x  ((To + 459.7)/(Ti +459.7))0.5

 
 where:   To = outside temperature when the Blower Door test was performed in oF.
 Ti  = inside temperature when the Blower Door test was performed in oF.
 
  Pressurization Test:
 
 Adjusted Flow (CFM) = Nominal Fan Flow  x  ((Ti + 459.7)/(To +459.7))0.5

 
 where:   Ti = inside temperature when the Blower Door test was performed in oF.
 To  = outside temperature when the Blower Door test was performed in oF.

 
�  % Error :  The % error column is the % difference between the temperature adjusted flows and the

flows calculated by the computer using the “best fit” Building Leakage Curve.  The CGSB
airtightness test standard requires that the error be less than 6% for each of the pressure stations.

 
�  Fan Configuration:  The configuration of the fan (i.e. which low-flow ring was installed) when

the data point was collected.
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 Sample Zone Data Report (without logo)

+/-
Zone

Pressure
+/-

Pressure
Ratio
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The data table in the middle of the Zone Data Report contains the following information:
  

�  Nominal Building Pressure:  Building pressure measurements (in Pa) for each target pressure at
which sampling was conducted, including the pre and post test building baseline measurements.
Building pressure data are not adjusted for measured baseline pressures.

 
�  Zone A-P3 Pressure through Zone F-P8 Pressure:  Zone pressure measurements (in Pa) for each

target building pressure at which sampling was conducted, including the pre and post test zone
baseline  measurements.  Zone pressure data are not adjusted  for measured baseline pressures.

 
 
ZPD Input Table:

The ZPD Input Table contains all of the test data required to be input into the ZPD Calculation Utility
program, used to estimate air leakage rates from zones monitored during an automated Blower Door test.
The ZPD Calculation Utility program is available at no charge from the Energy Conservatory website
(www.energyconservatory.com).
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Chapter 13    Cruise Control

The Cruise Control feature automatically adjusts the speed of the Blower Door fan to maintain a constant
building pressure while the operator or technician performs additional diagnostic or air-sealing procedures.
While cruising, the program displays the current building pressure and fan flow, and displays current zone
pressures if the zonal pressures feature is active.  However, TECTITE does not store fan flow, building
pressure or zone pressure data while cruising.  Common applications of the Cruise Control feature include:

�  Pressure pan testing for evaluating leakage in forced air duct systems.
�  Maintaining a constant building pressure while locating and sealing air leaks.
�  Quickly estimating the building leakage rate before conducting a full airtightness test.
�  Series leakage tests such as the Leakage Area Matching Method, or Add-a-Hole method to

quantify leakage rates between various zones within a building.

13.1  Starting the Cruise Feature

Before using the Cruise Control feature, be sure that the building and fan pressure tubing is properly
connected to the DG-700/DAB.

DG-700 Tubing Connections

APT DAB Tubing Connections

To outside
(green tubing)

To inside of building
(leave open if DAB is
in the building)

To  BD fan
(red tubing)

To space upstream of fan inlet.
(If fan inlet and DAB are in the
same space, leave open)

INPUT

REF

P1 P2

To inside of building
(leave open if gauge is
in the building)

To outside (green
tubing)

To space upstream of fan inlet.
(If fan inlet and gauge are in the
same space, leave open)

To  BD fan
(red tubing)

A B
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Note:  If you want to display building zone pressures while cruising, be sure the zonal pressures feature is
active, and you will need to connect hoses between the DAB and the zones being measured (see Chapter 10
for more information on zonal pressure testing.)

The Cruise Control feature is started from the Test Graph (Auto Method) Screen.  Cruising cannot begin
until a communication link has been established between your computer and the DG-700/DAB.  If a
communication link has not been established, the Start and Cruise buttons are grayed out and the message
DATA BOX NOT CONNECTED  appears in the DAB Status Window.  To establish communication, first
check to be sure that the serial cable between the computer and the DG-700/DAB has been properly
installed.  Also check that the DG-700/DAB has been turned ON and has power.  Once a communication
link has been established, the message Idle -  Monitoring  appears in the DAB Status Windows and the
Start and Cruise buttons are activated.

For more information on establishing a communication link between the your computer and the DG-
700/DAB, see Chapter 15, Problem 1.

To activate the Cruise Control feature, click on the Cruise button from the Test Graph (Auto Method)
Screen.  Now fill in the Cruise Pressure field and select a Baseline option in the Cruise Test Conditions
window which appears on screen.

Cruise Test Conditions Window

Cruise Pressure:

Enter the building pressure (in Pa) that you would like the Blower Door fan to maintain.  Always enter the
cruise pressure as a positive number, even if you are depressurizing the building.  For example, if the test
mode is set to depressurize, and you wish to cruise at a building pressure of -50 Pa, enter the cruise pressure
as 50.  The TECTITE program will now adjust the speed of the Blower Door fan until the cruise pressure is
achieved, and will continuously adjust the fan speed to maintain the cruise pressure.

Baseline:

�  No Baseline:    This option is used when you want to cruise without first measuring and
adjusting for the baseline building pressure.  In other words, you will not adjust the displayed
building pressure by the measured baseline building pressure. If you are displaying zone
pressures while cruising, they will not be adjusted for the baseline zone pressure.
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�  Cruise With Baseline:   This option is used when you want to adjust the displayed building
pressure by the measured baseline building pressure.  Use this feature when you want to
change the building pressure by the specified cruise pressure.  For most users, this is the
preferred cruising method.  If you are displaying zone pressures while cruising, they will be
adjusted for the measured baseline zone pressures.

After clicking on OK in the Cruise Test Conditions window,  you will be asked to indicate which flow ring
will be installed on the fan during cruising.  Click on the appropriate ring and then click on Proceed with
Cruise.  This allows the program to display the fan flow, as well as the building and zone pressures while
cruising.  Current fan flow and building pressure are displayed in the status windows on Test Graph Screen,
and by the moving cursor on the graph.5   The entered cruise pressure is displayed on the graph by a red
vertical line.  Current zone pressures are displayed in the zone pressure status windows located above the
graph.

13.2  Ending Cruise/Stopping the Fan

Once Cruise Control has been activated, there are two ways to turn off the cruise feature:

�  Click on Pause or press the Esc key.  This immediately stops the fan, and the operator is allowed
to either adjust the Auto Test Settings, re-start cruising or terminate the cruise procedure.

�  Click on Stop Cruise.  This immediately stops the fan and ends the cruise procedure.

13.3  Real-Time ACH50 Estimator

When the Cruise Control feature is active, TECTITE will display a real-time estimate of Air Changes per
Hour at 50 Pascals of building pressure (ACH50) on the Test Graph Screen.   To estimate ACH50,
TECTITE  uses the current measured fan flow, the volume estimate input into the Building Information
Screen, and an assumed Building Leakage Curve exponent (n value) of 0.65.  The ACH50 display window
is only active when the current building pressure is between 40 and 60 Pascals, and a valid fan flow
measurement is being made.  The on-screen ACH50 display is useful for quickly estimating building
leakage rates before conducting a full airtightness test.

                                                
5   If you activate the Cruise option while Blower Door data are being displayed on the graph, the data will remain on
the graph and will not be affected or changed in any way.
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Real-Time ACH50 Estimator

Note:  The Real-Time ACH50 display is also active when the DAB is in the Idle – Monitoring  mode and
the user is manually adjusting the fan speed (and the current building pressure is between 40 and 60 Pa).
The Real-Time ACH50 display is not active during an automated test sequence.

13.4  Using the Display Large Meters Feature

The Display Large Meters feature replaces the graph on the Test Graph (Auto Method) Screen with 3 large
status windows including Real-Time ACH50, Current Fan Flow, and Current Building Pressure.  The
feature can be toggled on and off by clicking on Display Large Meters from the Options Menu.

The Display Large Meters feature is particularly useful when looking at the computer screen from a distance
while cruising or manually adjusting the Blower Door fan in Idle-Monitoring mode.   The Real-Time
ACH50 display window is only active when the current building pressure is between 40 and 60 Pascals, and
a valid fan flow measurement is being made.  The Real-Time ACH50 display is not active during an
automated test sequence.

  Ring  A

ACH50 Estimator Window
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Large Meter Display

  Ring  A
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Chapter 14     Creating and Using Configuration Files

14.1  What is a Configuration File?

There is a significant amount of data entry required in filling out all of the screens of TECTITE.  A
configuration file is a place to save test settings, building and climate information, and comments that you
routinely use so they can be quickly loaded into the program.  The configuration file can then be used as a
shortcut for speeding up data entry for future tests.  A configuration file looks just like a building test file,
except that no test data (i.e. building pressure or fan flow readings) are stored in configuration files.6

14.2  How to Create a Configuration File

Before creating a configuration file, first be sure to save any current test data loaded into TECTITE by
using the Save Current Test File option from the File Menu.

Now select the New Test option from the File Menu.  Proceed through the Customer, Building, Climate,
Comments, and Test Settings Screens, filling in only the information which will be always be the same for
your testing.  For example, on the Customer Info screen you would not want to fill in the customer name but
you probably would fill out the technician name.  On the Building Info screen you would probably want to
fill in the heating and cooling pricing information for as many fuel types as you expect to see regularly.
However, you would not fill in the efficiency and SEER rating, since they will vary from one test to another.
If there are any “standard” comments which you would like to have on all tests, type them in on the
Comments Screen at this time.  On the Test Settings Screen, choose the settings you wish to save.   Finally,
open the Business and Fan Info and Com Port Selection windows (found in the Options Menu) and
complete the appropriate fields.

When you have finished entering information and settings that you wish to save, select Save Configuration
File from the File Menu.

When saving a configuration file, you will need to enter a file name in the file saving browser that appears
on screen.  You may also choose a different destination folder for the saved file by clicking on the Save in
window.  Once you have chosen a configuration file name and destination, click on Save.

Note:  All configuration files are automatically given a .cfa extension.

                                                
6  Information entered using the Options Menu (e.g.  Business and Fan Info Screens) are also stored when a
configuration file is created.
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Saving Configuration File Browser

14.3  How to Use Configuration Files

To use a configuration file when conducting a new test, click on New Test with Custom Configuration
from the File Menu.

After selecting the “Custom Configuration” option, a file browser will appear on screen which lists all the
configuration (.cfa) files contained in the current directory.  To select a file, click on the file name from the
list and then click on Open.  Once the configuration file has been selected, the file information is loaded
into the TECTITE program and the Customer Screen appears.  To change the folder being listed, click on
the Look in window.

Retrieving Configuration File Browser
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After loading the selected configuration file, complete the remaining data entry fields and proceed with the
test.   Importantly, you are not “locked into” the entries which were loaded from your configuration file.
You can always edit all data entry fields during the test.

Some users may wish to create custom configuration files for a variety of testing situations they frequently
encounter.  For example, a user may have separate configuration files for each city where they frequently
test.  Configurations can also be created which are specific to:

test location
house type
fan model and serial number
testing protocol (e.g. custom pressure lists or zone pressure setup)
calm versus windy conditions

Keep in mind that the Comments Screen can be a particularly useful part of custom configuration files by
containing “boiler plate” comments which you would like to print out (or edit) for all tests.

Note:   Because configuration files are so useful, we recommend that everyone create at least one
configuration file and call it “default.cfa”.  This file should contain your most frequently used settings and
information.  When you start a new test using New Test with Custom Configuration, the program will
automatically highlight the default.cfa file (if it exists) in the file selection browser, so all you need to do is
click on Open.
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Chapter 15     Troubleshooting TECTITE

15.1  Basic Tips

·  If there is an on-screen warning message, refer to the list of Operator Messages in Chapter 7.

·  If you are having trouble completing an automated Blower Door test, first check that the Blower Door
and DG-700/DAB system are set up as shown in Chapter 2.

Refer to example problems below for information on more specific operating problems.

Problem 1:   When trying to start an automated test or cruise procedure from the Test Graph Screen,
       the Start and Cruise buttons are grayed out and the message “DATA BOX NOT
       CONNECTED”  appears in the DAB Status Window.

Automated testing or cruising cannot begin until a communication link has been established between the
DG-700/DAB and your computer.  A number of different problems could be causing the DATA BOX NOT
CONNECTED message to appear.  To establish communication:

�  Make sure the DG-700/DAB is turned On and has power.

The DG-700 is powered by 6 AA batteries located in the rear battery compartment.  The
battery voltage for the DG-700 is displayed on the gauge immediately upon turning on the
gauge, and can also be read by clicking on the Data Box Info button on the Test Graph.
Replace the DG-700 batteries if the battery voltage drops below 6 volts.  Note: Always turn
off the DG-700 before replacing the batteries.  If this is not done, it is possible for the DG-700
to lock-up.  If this occurs, the gauge may not respond to any keys and you must:

- remove the batteries.
- hold down the ON/OFF button for approximately 5 seconds to clear the DG-700.
- replace the batteries.
- turn on the DG-700 and resume testing.

The APT DAB is powered by an internal re-chargeable NiCd battery.  Plug in the 12V power
supply supplied with the APT system to charge the NiCd battery.  The fully charged NiCd
battery will power the DAB for approximately 6 - 12 hours of testing.  The DAB can be also
be operated with the power supply plugged in.  If you are using your APT System for the first
time, we recommend that you fully charge the DAB battery overnight before beginning
testing.  The green light next to the connection terminal on the DAB indicates that the power
supply is providing power to the internal battery.

�  Make sure the serial cable is securely connected between the DG-700/DAB and computer.

�  Make sure that the COM Port Selection in TECTITE corresponds to the physical COM port on
your computer that the serial cable is connected to.  See Setting the COM Port in TECTITE  below.

�  Make sure you are not running 2 copies of TECTITE at the same time, both set to Auto Method.

�  Make sure that there are no other devices (such as digital cameras, serial mouse or keyboards)
attempting to use the COM port which you have chosen.  Shut down other programs that may be
running and interfering with communications through your COM port (such as PDA
synchronization software).  Be sure to check the section of the Windows task bar where the clock
appears for program icons that may be causing the problem.
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�  If you are using a USB to Serial adapter (because your computer does not have a serial port), make
sure the adapter is installed correctly.

�  If you have a continuity tester,  make sure that pins 2, 3 and 5 on the serial cable are continuous
from one end to the other and are not connected to one another.

Once a communication link has been established, the message “Idle – Monitoring ” appears in the DAB
Status Box and the Start and Cruise buttons are activated.

Setting the COM Port in TECTITE:

TECTITE allows you to specify the COM port on your computer which is being used to communicate with
the DAB.  To set the COM port, click on Options in the Main TECTITE Menu and choose COM Port
Selection.  The COM port selection window allows you to choose between 10 options;  AUTO SELECT,
COM1, COM2, COM3, COM4, COM5 and COM9.  If you know which COM port is being used, then
choose that port from the selection list.  If you are uncertain of the port being used, either choose AUTO
SELECT (which allows TECTITE to search for the correct port), or look up the port information using the
Device Manager in your computer’s operating system.  Note:  The Device Manager can be accessed on
most computers by right-clicking on the My Computer icon on your desktop and selecting Properties –
from the System Properties window click on Hardware, then Device Manager and finally Ports.

COM Port Selection Window

Note:  Whenever possible, it is best to select the proper COM port, rather than use AUTO SELECT,
because program operation will be faster, and depending on your computer’s port settings, AUTO SELECT
may not always provide a reliable communication link.  If you have successfully used the
AUTO SELECT setting to establish a communication link, you can determine which COM port
TECTITE is using by clicking on the DATA BOX INFO button from the Test Graph (Auto Method)
Screen.
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Problem 2:  During an automated  test, the program occasionally loses communication with the
                    DG-700/DAB and displays the message “Communication lost.  Testing ended.”

Intermittent communication problems are typically caused by another program, or your computer’s power
management system, interfering with communication through the selected serial communication port.

�  Shut down other programs that may be running and interfering with communications through your
COM port (such as PDA synchronization software).  Be sure to check the section of the Windows
task bar where the clock appears for program icons that may be causing the problem.

�  Turn off power management features that may be shutting down the COM port.

�  Turn off any program that alters your system clock, for example some power management schemes
automatically correct the system clock at regular intervals.  The “device drivers” which make these
corrections are not always turned off automatically when the power management features are
turned off.  You may need to manually disable these device drivers.

�  Turn off the automatic reset option found in Control Panel ...Accessibility Options ...General.

�  Check the serial cable for intermittent connections.  Use a continuity tester to make sure that pins
2, 3 and 5 on the serial cable are continuous from one end to the other and are not connected to one
another.
 

Problem 3:  During an automated  test, the program never starts taking data at a target pressure line, 
      even though the Flow and Building Pressure Cursor appears to be bouncing around the 
     target pressure.  After a few minutes the message  “Warning:  Excessive building 
     pressure fluctuation.  Check A/P1 tubing / increase Target Tolerance.” appears.

In order for the TECTITE program to start taking data at any target pressure line, it must first determine that
the current measured building pressure is within a specified range from the target building pressure. This
specified range is called the Target Tolerance.  If the current measured building pressure is
fluctuating beyond the Target Tolerance, then data collection for that target pressure will not begin.
Fluctuating building pressure readings can be caused by improper installation of the building pressure
reference hose, or by windy weather.

�  First check to be sure that the outside end of the building pressure tubing (e.g.  the green
tubing connected to the Channel A/P1 Reference tap) is not placed directly in the exhaust air
flow of the Blower Door fan.  You must be careful to run the end of the tubing well away (at
least 5 feet to the side) from the exhaust of the fan.  A good location for the end of the
building pressure tubing is at the base of the building where it meets the ground.

Note:  Although it is common practice for Blower Door operators to insert the open end
of the building pressure tubing a few inches through the patch on the nylon panel, and
leave it, we have determined that this set up practice can create inaccurate building
pressure readings due to the exhaust airflow from the fan hitting the end of the tubing.
You should always follow the tubing set-up practice listed above to prevent fluctuating
building pressures.

�  If the building pressure tubing is installed correctly, the fluctuating building pressures are
probably caused by wind.  Try increasing your Target Tolerance to 3 or 4 from the default
value of 2  (see the Test Settings Screen).   If this doesn’t work, you may increase the Target
Tolerance to 5 or greater, or use the Sample button (see below).
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Note:  As the Target Tolerance is increased from the default value of 2, gathered data
may not be as close to the pressure stations as would be the case when using the default
value.  This has negligible effect on the final test results.  However, some test standards
do require that the measured building pressures be within a specified range of the pressure
station (e.g. the CGSB test standard requires that the measured building pressures be
within +/- 2.5 Pa of the specified pressure stations).

Sample Button:

During an automated test, you can manually instruct the computer to go ahead and take data by clicking on
the Sample button.   At this point, the computer will proceed just as if it has decided that the Target
Tolerance for the current pressure station line had been met.
 
 
Problem 4:  The Blower Door fan seems to be oscillating during automated testing or when using the 

     Cruise feature.

Try decreasing the Fan Adjust Rate (see Test Settings Screen).  Decreasing the Fan Adjust Rate makes
the fan adjust more slowly when seeking the target building pressures, and should reduce oscillation.  First
try changing the Fan Adjust Rate to 0.2 from its default value of 0.5.  If this doesn’t work, decrease it
further (minimum value is 0.1).  If you are still having problems with oscillation, contact The Energy
Conservatory (www.energyconservatory.com) for technical assistance.

Problem 5:  My computer seems to lock-up during automated testing.

�  Make sure that there are no other devices attempting to use the COM port which you have
chosen (such as an infrared printer driver).  Use the Device Manager in Windows to check this
- the Device Manager can be found in Control Panel...System.

�  Shut down other programs that may be running and interfering with communications through
your COM port (such as PDA synchronization software).  Be sure to check the section of the
Windows task bar where the clock appears for program icons that may be causing the
problem.
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Chapter 16     Evaluating the Repeatability of Test Results

You may have wondered how much the test results of a building would change if you immediately repeated
the test and compared the two results.  The amount of possible change from one test to another is called
“repeatability”.  The TECTITE program calculates an estimate of test repeatability and displays this
estimate along with the test results.  Note: This estimate assumes the building was unchanged from one test
to another and the weather conditions were similar.

One of the strengths of automated Blower Door testing is its ability to automate the data collection process
and make repeatable airtightness measurements in both calm and windy weather conditions.  During
automated testing, TECTITE is able to quickly gather and analyze hundreds of times more readings during
a single test sequence than would be practical with a manual Blower Door test.  By quickly collecting large
samples of data, the repeatability of test results is greatly improved over manual test methods without
laborious data entry or hand calculations.  In addition, if very good repeatability is needed, multiple tests on
the same building can be quickly performed and combined on the Test Graph to further increase the test
precision.

16.1  Looking at the Repeatability of Test Results

The repeatability of the test results can be quickly evaluated by looking at the calculated standard errors that
are shown on the Test Results Screen (i.e.  the “ +/-    % value shown to right of Airflow at 50 Pascals,
Leakage Areas and Building Leakage Curve results - see the figure below).7   Once a test has been
completed, look at the Test Results Screen to determine if the repeatability of the test results is sufficient to
meet your needs.

Calculated Standard Errors of Test Results

Note:  Standard error calculations are reported when using both Auto and Manual Test Methods.

The standard errors, shown as a percentage of the measurement, give you an estimate of how much the
measurement could change if you repeated the test.  For example, from the figure above, a 1.4 % standard
error in the CFM50 reading of 1,484 means that if you repeated the test, the new CFM50 reading would not

                                                
7  These standard errors are statistical estimates of repeatability calculated according to CGSB Standard 149-10 M86.
One assumption made is that data points deviate from a straight line due to random variations in pressure and flow
measured during a test.

Standard
Errors



Chapter 16     Evaluating the Repeatability of Test Results

TECTITE
Version 3.2

73

likely differ by more than 20.8 CFM50 (1,484 x 0.014).   In this case the repeatability of our CFM50
reading is quite good since separate repeated tests of this building would likely produce readings of between
1,463 and 1,505 CFM50.

If you are conducting an airtightness test to simply measure the current airtightness level of a building, or to
estimate the natural infiltration rate of a building, we suggest that standard errors of test results on the order
of +/- 5.0% are generally acceptable.  The results in the figure above are all well within our recommended
5.0% guideline.

If on the other hand, you are comparing two or more Blower Door tests to determine a change in
airtightness (e.g. to document the performance of airsealing work, or as part of the “open a door” series
leakage diagnostic procedure, etc.), then better repeatability may be warranted.  When comparing two
Blower Door tests, we often recommend that the standard error in both tests be less that 20% of the
measured change in airtightness.

For example, suppose we conducted two separate tests on a building, one before airsealing was performed,
and one after airsealing was performed, and the results of the tests were as follows:

�  Pre Airsealing CFM50 =    2,565  (+/-   3.2%)   standard error = 2565 x 0.032 =  82.1

�  Post Airsealing CFM50 =   2460  (+/-    2.9%)  standard error = 2460 x 0.029 =  71.3

The calculated change in airtightness =  105 CFM50  (2565 minus 2460).   20% of the change in
airtightness = 21.0 (105 x 0.2).

In this case, both test standard errors of  82.1 and 71.3 are greater than 20% of the measured change (or
21.0), therefore we should not accept the measured change of 105 CFM50 as a valid result.  We would need
to increase the repeatability of our tests (i.e. reduce the standard error) in order to accurately measure this
relatively small change in building airtightness.

16.2  Improving the Repeatability of Automated Test Results

The simplest way to improve the repeatability of automated test results is to conduct one or more additional
tests and have the TECTITE program combine all data into one test result.  Data from more than one test
can always be combined on the graph. This occurs when starting a new test sequence while data from a
previous test are currently on the graph screen.  For example, if you perform a test and after reviewing the
Test Results Screen you would like to increase the repeatability (i.e. reduce the standard error) of the test
results, begin another test (by clicking on the Start Test button), and do not clear the previous data prior to
starting the second test.

When viewing the Test Results Screen and there are data from multiple tests on the graph, results are
calculated using all data points displayed on the screen.8   In addition, the Completed Test Indicator on the
Test Graph Screen will be updated to reflect the number of completed tests being displayed.

Note:  When combining multiple tests, the calculated standard errors in the results will generally decrease
as more tests are added.  However, the calculated correlation coefficient will typically remain about the
same and may even get worse.  Therefore, when evaluating the repeatability or precision of a test, the most
important factor to consider is the standard errors in the test results

                                                
8   When there are multiple test results on-screen, TECTITE adjusts the collected data for each individual test by the
baseline building pressure readings taken immediately before and after that test.
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16.3  Improving the Repeatability of Manual Test Results

Improving repeatability when conducting Manual Tests is not as easy.   However, there are a few simple
strategies for increasing Manual Test repeatability.

�  Collect more data points during each test.  The manual entry Data Table will accept up to 10
sets of Blower Door test readings.  Collecting 10 set of Blower Door data will almost always
increase repeatability over collecting 5 sets of data.

�  Conduct separate multiple tests and manually average the calculated results.
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Chapter 17     Entering Custom Fan Calibration Parameters

The TECTITE program comes installed with factory default fan calibration parameters for the 110V and
230V Model 3 Minneapolis Blower Door fans, the 230V Model 4 (CE approved) Blower Door fan, and the
Series A and B Duct Blaster fans.  The fan calibration parameters are used by the program to convert the
measured fan pressure in Pascals to airflow in Cubic Feet per Minute.

If your Blower Door fan was custom calibrated by The Energy Conservatory, you can input your custom
calibration parameters directly into the TECTITE program in lieu of the factory default values.  To enter
custom calibration parameters, first open the Fan Information window by clicking on Options...Fan Info
from the Main TECTITE Menu.

Fan Information Window

From the Fan Information window, select the appropriate fan model, and then click on the Enter Custom
Calibration button to open the Fan Calibration Parameter window.

Fan Calibration Parameter Window
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The Fan Calibration Parameter window shows the calibration parameters being used by the program for the
currently selected fan type.  There is a unique set of parameters for each of the flow ring configurations
used with the fan.  The individual calibration parameters can be selected for editing by using the Tab key,
or by clicking on the input fields.  Whenever you input a custom calibration parameter, the new value
shown in the field will be displayed in red, rather than black for the default values.  You can easily return all
calibration parameters to the factory default values by clicking on Set to Defaults.  The currently entered
fan calibration parameters are stored as part of the data file.

Note:  Most users should never have to edit fan calibration parameters.  The default fan calibration
parameters which come with TECTITE should work fine for all standard Minneapolis Blower Door and
Duct Blaster fans.  This feature is necessary only if you receive custom calibration parameters for your fan
from The Energy Conservatory.



Chapter 18     Using the Compare Tests Feature

TECTITE
Version 3.2

77

Chapter 18     Using the Compare Tests Feature

The Compare Tests features allows you to select two previously saved building test files and to quickly
compare the stored test results.  To use this feature, select File from the Main TECTITE Menu, and then
click on Compare Tests which appears in the File Menu.

18.1  Choosing the Test Files to Compare

After selecting the Compare Tests option, a file browser titled “Select Building Test File #1 to Compare”
will appear on screen which lists all the building (.bld) files contained in the default folder.  Select the first
file by clicking on a file name from the list and then click on Open.  Once the first file has been selected, a
second file browser titled “Select Building Test File #2 to Compare” will appear.  Select the second file and
once again click on Open.  To change the file folder being listed, click on the Look in window.

After both files have been selected, a comparison of the test results from the two files will be displayed on
the screen.  Both the numeric change and percent change between the two tests are displayed for each of the
test result items.  If a test result item is missing from one or both of the building files, then comparison
results for that item will not be displayed.  If zone data were collected for either building file, it can be
viewed by clicking on the Zone Data button.  A graph comparing the building leakage curves for both
selected building files can be viewed by clicking on the Test Graph button.

To exit the Compare Tests feature, simply select a different option from the top of the FILE  menu, or exit
the TECTITE program.

 Select Building Test File #1 to Compare
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18.2  Printing and Preview Options

Printing and previewing options for the Compare Tests feature are available by clicking on File in the Main
Menu.

The Comparison Report contains the same information that is displayed on the Compare Test Results
screen, plus any zone data that were collected for either building file. The Comparison Graph displays the
building leakage curve for both selected test files.  The printing and preview functions within TECTITE
utilize the Windows printer drivers and configuration options currently installed in your computer.
Windows printer setup options can be accessed by clicking on   Start....Settings....Printers.


